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Support Information 
Help File 

The main source of documentation for The Labor Contractor's Office is 
located within the program, in the Help file.  Answers to our most 
frequently answered questions and specific instructions are quickly 
accessed by using this file.  If you have questions while in a window, 
press the [F1] key to access help for that particular window.  Or, you 
can search the index by typing in key words.  The Help program is 
located on the Help menu. 

Phone 
If you have questions or need assistance using the Labor Contractor’s 
Office, and can’t find your answer in the Help file, call our toll free 
customer support line:   (800) 833-8824 and select the support option. 

Fax 
If you have a question or problem with a certain report, most of the 
time it is helpful for you to email or fax a copy so that we can see 
exactly what you are talking about.  Our fax number is (559) 226-5418.  
Click on the email button in the Print Preview window to email a copy 
of a report to us. 

Email 
You may send questions via email to our support department at 
support@datatechag.com.  We send out a weekly support bulletin by 
email.  To subscribe to the bulletin, send an email to 
support@datatechag.com. 

Support information may be found on this page on our web site: 

http://www.DatatechAg.com/support 

You may download updates to the program by using the Check for 
Updates option on the Tools menu in the program. 

Remote Assistance 
Support is also available using UltraVNC, an open source remote 
communications program.  This allows you to connect to our 
computers, show us what is happening on your computer and transfer 
program updates directly to your computer.  UltraVNC is included with 
The Labor Contractor’s Office.  Click on the blue UltraVNC icon on 
the button bar to install UltraVNC.  

General Support Information 
If you are reporting an error that you received, please provide as much 
detail as possible.  For instance, if you get an error, we will need to 
know which window you are on, what you did immediately prior to 
getting the error, the error number, the error line, the version number 
and any additional information in the error message. 

In some cases, we may need to get a "print screen" to see exactly what 
is happening if you are not using pcAnywhere or UltraVNC, or request 
a copy of your files to duplicate a problem.  If you have Internet access, 
you can send us a copy of your files for diagnosing problems by using 
the Backup & Restore option on the Tools menu.  Simply check the 
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“Send Backup to Datatech” option when making the backup and your 
backup file will be uploaded to our server. 

If you have suggestions for new features, improvements, new reports, 
etc., again, the more detail the better.  For instance, to create a new 
report it would be helpful if you design a mock-up of how the report 
would print, in addition to what selection criteria you would like. 
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Startup Wizard  
The first time you start The Labor Contractor's or The Farmer’s 
Office, the Startup Wizard will guide you through some basic 
setup tasks.  Once the startup wizard is completed, it will not 
appear again.  Don’t worry if you need to skip entering some 
information in the startup wizard; it can always be put into the 
program later. 

 

 
 

This is the opening page of the Startup Wizard.  Click on the Next 
button to continue.  (All wizards in The Labor Contractor's Office 
have an opening page that tells you what they do.) 

 

 
 

Enter the company name and access code that we have provided 
for you.  When a valid access code is entered for the company 
name that you enter, the Next button will be enabled and you can 
continue to the next page.  If the access code is not valid for the 
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company name, the Next button will remain disabled.  Double 
check how you are typing in the company name and access code.  
Contact Datatech customer support if you have a problem with the 
access code not working. 

If you are installing an evaluation copy, click on the Evaluation 
button and a company name and access code will be provided for 
you.  When you are installing the evaluation version, the next page 
in the wizard will allow you to select which optional program 
modules you would like to activate.  Available options are 
Accounts Receivable, Magnetic Media Reporting, Crop 
Management Billing, and Crop Cost Accounting.  The Crop 
Management Billing and Cost Accounting options are not used by 
most labor contracting companies, but you may want to turn on the 
Accounts Receivable and Magnetic Media options. 

 

 
The next page contains your company information.  Type the 
appropriate information for each entry and then click on the Next 
button. 

 
The next page contains Labor Contractor company information, 
such as license number, worker’s comp information, etc.  Type the 
information appropriate to your company and click on the Next 
button.   
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This page handles set up of your bank account(s).  The Labor 
Contractor's Office can handle up to 99 different bank accounts.  
This page will let you set up four different accounts.  Type in the 
account names, and if they are checking accounts, the next check 
number to use.  When you are done, click on the Next button. 

 

 
The next page lets you specify which accounts to use for various 
kinds of checks.  Some companies have a primary checking 
account that they write their vendor checks from, with another 
account that payroll checks are written from.  The Labor 
Contractor's Office keeps track of which accounts to use for each 
type of check. 

 

The bank account descriptions that you entered on the prior page 
may be selected for each of these entries.  If you only have one 
bank account, then it will be used automatically for all types of 
checks. 
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This page allows you to select the style of checks that you use in 
your laser or ink jet printer.   

There are two different settings that affect how checks print out: 
the check position and the check style.  The check position may be 
either at the top with two stubs, as pictured, or it may be in the 
middle with a top and bottom stub as pictured.  (The check can 
also be on the bottom if you are setting up a custom check format. 
If setting up a custom format, you do not need to change any 
selections in this wizard.  You will set up these details later in the 
custom check format.)  

Both payroll and payables use blank stubs.  A quarter inch is 
reserve at the top of the stub to print your company name and 
address, but the rest of the stub should be blank.   

Additional check format options are available in the Program 
Setup.   You can set the format in the Startup Wizard to Standard, 
and then change later if you need a different format.  If you are not 
sure which format to use, you can just select the Standard option 
and try printing checks on blank paper to see if they line up with 
your checks. 

If you need a custom format please contact Datatech for more 
information on setting up custom checks, or look in the on-line 
help for “custom check formats”. 
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This page handles setup of several payroll settings that are unique 
to each individual company. 

Keep in mind that if you are midway through the year and will 
need to enter payroll checks for the first part of the year to catch 
up, you should pick 1 as your current quarter. 

If you don’t have your federal and state ID numbers or 
unemployment rate handy, these can be entered later. 

Enter the state postal abbreviation for the State for Withholding, 
such as CA for California, AZ for Arizona. 

The grid in the top right part of the wizard lists several preset 
miscellaneous deductions.  Check the box for each of the 
deductions that you’ll need to use on employee checks.  If you 
need to add other types of deductions, you can do that later (see the 
section on Miscellaneous Deductions). 

Also, select the type of employees that you have according to the 
tax form that they are reported on.  Some agricultural businesses 
simply classify all employees as 943 (Ag), while others may report 
office and other non-ag workers as 941 (Regular) employees. 
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Select the ending month of your fiscal year.  The wizard will show 
you the starting and ending months and years of your current fiscal 
year. 

 

 
 

If you want to require a user name and password when you log in 
to The Labor Contractor’s Office, enter these on this page.  (The 
password will show asterisks (*) instead of the letters you are 
typing so that your password will not be visible.  You’ll need to 
enter the password twice to confirm it.) 

You will want to choose a password that you can remember easily, 
but will not be known to other people.  A user name and password 
are not required by the program.  If you would like to open the 
program without requiring this, simply leave the fields blank and 
click on next.  If you are using this as an evaluation copy and do 
not need to protect the information contained within, you do not 
need to have a user name and password. 

Additional names and passwords can be added once the program 
has started. 

Click on the Finish button and the Startup Wizard will complete 
the startup work, and then you will be able to start using The Labor 
Contractor's Office. 
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Using the Program 
As much as possible, we have designed The Farmer’s Office to have 
the same "look and feel" as other standard Windows based applications.  
This will make learning how to use The Farmer’s Office easier for 
those who are already familiar with other Windows programs. 

The Button Bar 
Located just below the main menu, the button bar gives you an easy 
way to control file operation with the mouse.  If you ever forget any of 
the functions of the buttons, just hold the mouse pointer over one and a 
"ToolTip" will appear to let you know what it does. 

 
The find buttons behave 
differently depending on 
which entry filed the cursor 
is in. For instance, on the 
G/L Chart of Accounts 
window, if you press the 
“Find First” button in the 
Account # field, the first 
account number will be 
display.  If you press is it 
when the cursor is in the 
Description field, then the 
first account description 
alphabetically will be 
displayed. 

The first four buttons on the left are used for finding records in files.  They are 
in order from left to right: 

 Find First Record in File 

 Find Previous Record in File 

 Find Next Record in File 

 Find Last Record in File 

In the next group of buttons, the magnifying glass will activate a popup selection 
list (if one is available for the entry that the cursor is currently on).  The middle 
button will clear the current record that you are looking at. The button on the 
right will clear all files in the current window. 

The next group of two buttons will save (the disk) or delete (the X) the current 
record you are looking at. 

The next group of three buttons are the standard windows functions of 
cut, copy and paste.  You can cut or copy information from any data 
entry window into another. 

The last group of buttons are different from the others: these buttons 
open specific windows.  From left to right, the buttons open the 
Checkbook Register, Employees, Cost Centers, and Crop Notes.  
Depending on your version of The Farmer’s Office, your button bar 
may have different buttons available. 

Using the Keyboard  
Wherever possible, we have designed The Farmer’s Office to provide a 
great deal of flexibility in terms of how you operate the program.  
There are often several different ways of doing something, both with 
using the keyboard and the mouse.  For instance, to save an entry, you 
might press [F2], click on a button labeled "Save" in the data entry 
window, press the [Ctrl]+[S] key combination, or click on the Disk 
icon on the toolbar. 

On data entry windows, you can move from one entry to the next by 
pressing [Enter] or [Tab].  Use [Shift]+[Tab] to move to the previous 
entry.  You can also move the mouse pointer to a specific entry field 
and click on it to move the cursor there. 
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When a button is selected, pressing [Enter] or [Space] has the same 
effect as clicking on the button. 

As you begin to use The Farmer’s Office, you'll notice that the color of 
the data entry windows turns yellow as the cursor moves into them.  
This is just a visual aid to help you locate the current "active" field (in 
technical terms, the "focus").  When the "focus" is on radio buttons, or 
checkboxes, or buttons, you'll notice a dotted outline instead of a 
yellow highlight. 

Function Keys 
Function keys have been defined for common actions: 

 [F1]  Help 
 [F2]  Save 
 [F3]  Close Window 
 [F4]  Lookup 
 [F5]  Clear 
 [F6]  Move to next area/tab page 
 [F7]  Find Previous 
 [F8]  Find Next 
 [F9]  Find 
 [F10]  Menu 
  [Shift+F2] Delete 
  [Alt + F5] Clear All 
  [Alt + F4] Exit Application  

Finding Records and Lookups 
You can get a lookup list for each of the main files (such as vendors, 
general ledger accounts, employees, cost centers, etc.).  These lookup 
lists are activated by clicking on the button with the mouse pointer or 
by pressing [F4] in the entry field. Entry fields where lookups are 
available, are indicated by a lookup button with three periods added to 
the right end of the field, as shown below: 

 
In this example from the Vendor Invoicing window in Accounts 
Payable, there are lookups available on the Account # and Name Key 
entries that will allow you to select a vendor account.  There is a lookup 
button on the Invoice # entry also which will allow you to choose an 
existing invoice from the Invoice Lookup.  There is also a lookup on 
the Terms entry which will allow you to select a different vendor terms 
record. 
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Lookup buttons also appear on the Invoice Date and Net Due entries.  
These buttons will activate a calendar window where you may select a 
date to be entered. 

Without using the lookup, you can also perform finds in these fields.  
For instance, suppose you are entering a chemical application and you 
are looking for the chemical DIBROM 8 EC.  You might type in just 
"DIBR" and press [F9] to find the product.  The program will attempt 
to find the closest match to what you have typed in.  If the chemical 
that is displayed in not the one you want, you can use the [F7] and [F8] 
to find the previous and next chemicals.   

Keyboard Shortcuts 
Shortcut keys provide an alternative to using the mouse.  You don't 
have to use keyboard shortcuts, but they are provided as a faster way of 
using the program.  By using a keyboard shortcut, you don't have to 
move a hand from the keyboard to the mouse and back.  Keyboard 
shortcuts are indicated by an underlined letter.  In most cases the 
options on a popup menu will also have shortcuts listed. 

There are two different types of shortcuts: menu shortcuts and 
navigation shortcuts. 

Each menu option on the main menu has a letter underlined: 

 
Instead of click on the menu options, you can hold down the [Alt] key 
and press the letter that is underlined.  For instance, to access the 
Payables menu, you would press [Alt]+[Y].  You can use these 
keyboard shortcuts at any time, except when a modal dialog window is 
open. 

Once you have activated one of the main menu options through the 
keyboard shortcut, each submenu item can be accessed simply by 
pressing the first letter of the submenu. 

 
In this example, you can access the Crews screen by pressing [C] or 
press it again to switch to the Checks sub menu by pressing [C], etc.  
Pressing [E] will alternate between the "Employees" and the 
"Employee Lists" option. 
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Report Print Preview Window 
All reports can be previewed on the screen before you actually print 
them on paper.  The report preview window looks similar to the 
following: 

 

 
The preview screen has a button bar.  The button functions (from left to 
right) are save, print, email, show full page, fit page width, zoom in, 
zoom out, first page, previous page, next page, and last page, help, 
about, and close.   

Use the scroll bar at the right edge of the window to scroll up and down 
if the entire page is not visible on the screen. 

To jump to a specific page number, click on the page number at the 
bottom of the window. 

If you click on the Print button, the standard Printer dialog will appear 
for you to select which printer you want the report to be printed on. 

When you click on the email button, the Compose Message of your 
email program window will appear.  The report will be automatically 
attached to this email in Adobe Acrobat (PDF) format.  The recipient 
will need Adobe Acrobat Reader to view or print the report. 
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Program Setup 
The Program Setup is located on the Tools menu.  The settings in the 
Program many entry and reporting options for all of the accounting 
modules. 

Company Information 
You can update your company information at any time on the Main-
>Company Information tab.  If you need to change your Company 
Name, please call Datatech for a new registration code. 

 
This document will not cover all of the available options in the 
Program Setup, but as discussed during the training session, you may 
want to make some notes here: 

 

 

 



17 
 

Custom Check Formats 
Several different check formats for payables and payroll checks are 
preprogrammed into the Datatech Accounting Software.  If your checks 
do not fit one of these preprogrammed formats, you can use the Custom 
Check Format Definition option to specify exactly how you need the 
check to be printed.  You provide the size the check, stubs, and 
positions on the check to print each item.  After creating the check 
definition, this option will be added to the "Check Style" options in the 
Program Setup option. 

In addition to handling custom check layouts, the Custom Check 
Format Definitions also allow you to modify how the check stubs are 
printed for both payroll checks and vendor payables checks (but not 
direct expenses checks).  An option is also available for printing on 
blank (not preprinted) check stock. 

Keep in mind that once you have created your custom check definition, 
you still need to select it as the Check Style in the Program Setup 
option.  We recommend that you then try some test printouts on blank 
paper to make sure that everything is printing in the right place. 

The Custom Check Format option is located on the Tools menu.  When 
you pick this option, the following window will open: 

 
Format 

Enter a name for this format.  You might for instance enter the 
name of the forms company and their form number. 
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Length of Check & Stubs 

Enter the length, in inches, of the combined check and stubs.  
Common lengths are 11" for a single check plus two stubs. 

Horz./Vert. Positions 

For each item, enter the position (both horizontal and vertical) in 
inches where each item should print on the check.  If any item does 
not have a position specified (in other words, you leave the entries 
at zero) then that item will not appear on the check. 

The Amount and Account # items are numeric and are printed right 
justified based on the position that you enter. (All of the other 
items are left-justified.) 

If your check format has a memo line, the last two items, Our 
Account # and Check Description, will be used for vendor checks.  
You can print your account number with the vendor (e.g. a loan 
account #, credit card account, etc.) and/or the check description 
that you enter on each check. 

On most check formats, there is a space set aside for printing the 
name and address of the payee.  Some formats, such as 
Quicken/Quickbooks, also have a separate Pay To line, where only 
the company/individual name is printed.  Use the Pay To (Name) 
entry to print just the payee name on this line. 

Print Stub #1/#2 

Check these boxes to indicate that you want the stubs printed.  If 
you have a 7" check format with only one stub, you would only 
need to check the first box. 

Stub #1/#2, Vertical Position 

Enter the vertical starting point for printing the stubs from the top 
of the page, in inches. 

Stub #1/#2 Length 

Enter the length in inches of each stub. 

PR Message 

Specify the horizontal and vertical positions to print messages on 
the employee’s check stub.  Also, enter the width of the message.  
The message that prints on the check stub may be a standard, 
custom, or conditional message (or a combination of the three) 
depending on settings you have entered for the Check Messages 
section of the Payroll settings on the Program Setup window, and 
for the Check Stub Message entered on the individual employee 
accounts. 

Font Settings 

Click on the Select button to choose a font and point size to use 
when printing the check.  The default settings are the Arial font at 
10 point. 

Signature Settings 
A signature can be printed automatically on checks that are printed by 
the program.  This feature is only available if you set up a custom 
check format; a signature cannot be printed with any of the 
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preprogrammed check formats.  To print a signature, you must first 
scan a signature and save it as a Windows BMP, PNG, GIF, TIF or JPG 
file.  (BMP, PNG, TIF or GIF are recommended formats since these 
formats perform lossless compression.  You may see compression 
artifacts in signatures stored in JPG format.)   

In this section, you’ll tell the program where the bitmap file is located, 
where to print it on the check and how big it should be. 

BMP Filename 

Enter the full path and filename of the BMP file.  Click on the 
folder button to the right of the filename to select a file from the 
Open File dialog. 

The program supports other graphics formats besides BMP, 
including GIF, JPG, TIFF, and PNG.  A lossless graphics format is 
normally best for printing signatures.  PNG is usually the best 
format since it is lossless and has better compression than BMP 
files. 

Position 

Enter the vertical and horizontal positions in inches to print the 
signature file at.  This is the position of the upper left corner of the 
signature file.  Depending on how much white space there is 
around the signature itself, you may need to experiment a little 
with positioning the signature so that it appears on the signature 
line preprinted on the check. 

Size 

Enter the width and height to print the signature file. 

$ Limit 

As a security measure, you may set a dollar limit above which a 
check will not have a signature automatically printed.  Checks 
above this amount will require will have to be signed by an 
authorized signer on the account. 

Password 

You can set up a password that must be entered prior to printing 
checks with a signature.  This is also a security measure.  If the 
password is not entered, then the program will still print the 
checks, but it will not print the signature on them.  When you type 
in the password, asterisks will appear for each letter you type in.  
You must retype the password to confirm it. 

Options 
Click on the Options button at the bottom left corner of the window to 
open a popup menu with the following options: 

Check Layout Test Print 

This will print a sample check using the settings on the Check 
Layout tab.  This sample check does not use any settings to print 
the stub from the payroll or payable check stub tab pages.  A box 
will be drawn indicating the area reserved for each stub.  To 
preview how the stubs will look, it is necessary to print an actual 
check. 
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Print Check Layout Settings 

This will print a single page with the check layout settings.  This 
was originally meant to facilitate using the same check setting for 
another company, but it is easier now to simply export and import 
the check format settings. 

Print Signature Template 

This option will prompt you to enter some dimensions from your 
checks. Using these, it will print out a template that you can sign. 
This can then be used as your signature bitmap. 

Check Layout Defaults 

This option has a submenu with four different options.  Each 
option will set up default values for the check layout and stub 
positions according. 

Export Settings 

Use this option to export all of the settings to a check definition 
file which can then be imported into another company.  This makes 
it possible to create a custom check format once and re-use it for 
multiple companies. 

The check definition file includes all of the settings on the Custom 
Check Format Definitions window, including the Blank Stock 
Settings, Payroll Check Stub and Payable Check Stub.   

The default location for storing the check definition file is in the 
“Definitions” folder under the main application folder.  Check 
definitions file will use the extension “.dtcheckxml”. 

Import Settings 

This option can be used to import a previously exported check 
definition.  Select the check definition file to import and the setting 
will be imported and displayed. 

 

 

 



21 
 

Backup & Restore  
The Backup & Restore option is located on the Tools menu.  This 
option will create a backup of your data files only.  It does not backup 
program files or any of the “support” files necessary to operate your 
Datatech Accounting Software.  The backup file is a standard 
compressed ZIP file, which can be read by many different programs 
(for instance WinZip).  Windows also includes direct support in 
Explorer for reading files stored in a ZIP file. 

The Restore option will “unzip” the files stored in a backup file, 
replacing the files in your current company.  You should exercise great 
care when using the Restore option.  The Restore operation does 
overwrite your current files, so if you restore the wrong files and you 
do not have actually have a backup, you will lose you data.  Datatech 
cannot assume any responsibility if the Backup and Restore options are 
not used properly. 

If you are currently using a backup program, you may not need to use 
the Backup option built into your Datatech Accounting Software.  Your 
backup job may be backing up the entire program directory (not just the 
data files) as well as other important data files (word processing 
documents, spreadsheets, etc.).  Also, if you have multiple companies, 
you will probably find it more convenient to continue using your 
current backup software, since it can backup data files for all of your 
companies at the same time. 

Backing Up Data 
When you select the Backup & Restore option from the Tools menu, 
the following window will open: 

 
There are two other options on the Backup window.  First is the 
Backup Type.  You can select either Full or Minimal.  A Full backup 
will include all data files with their index files.  A Minimal backup will 
include just the data files without the index files.  When a Minimal 
Backup is restored, the files will be need to be reindexed.  This will be 
handled automatically by the Restore option.  A Minimal backup will 
require less space than a Full backup.  This may be more of a 
consideration if you are using floppy disks to back up.  If you are using 
larger capacity backup media, we suggest using the Full backup. 

Second, there is a checkbox called Send Backup to Datatech.  This can 
be used if you have Internet access, and you need to send a copy of 
your files to Datatech to diagnose a problem.  After the backup file has 
been created, the program will automatically upload the file to our 
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server.  You would normally not use this option unless you are working 
with Datatech Customer Support. 

If you are on a network, 
make sure that all users 
have exited the program 
before starting the backup.  
If the Datatech Accounting 
software is open on other 
computers, the data files 
will be in use and cannot 
be backed up. 

As mentioned before, the program creates a standard ZIP file when a backup is 
done.  This filename of the ZIP file is based on your company name and the 
current date.  For instance, a backup done for “Richard’s Farming, Inc.” on 
12/20/05 will be called “RICHARDS_FARMING_INC_12202005.ZIP”.  
Because the date is a part of the filename, a single drive or folder can contain 
multiple backup files.  But this also means that you can only have one backup 
file per day on a single driver or folder. 

Click on the Start Backup button to begin the backup.  The window will expand 
and you’ll see a status line, progress bar, and results box that shows the progress 
of the backup operation. 

Sometimes there may be errors during the backup process.  Normally, 
you do not need to worry about warning errors, as shown below: 

 
In this case, the backup did not find any QDF files (Query Definition 
File) which would be the case if you don’t use the Query option on the 
Tools menu. 

In other cases, there may be serious errors: 

 
In this example, the backup was done while the program was open by 
another user.  Data files open by another user cannot be backed up, as 
indicated by the last line in the results box: “139 files skipped”.  If this 
happens, make sure all users have exited the program (and that you do 
not have another copy of the program loaded on your computer) and try 
the backup again. 

When the Backup has been completed, the program will be restarted 
automatically. 
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Downloading Program Updates 
Updates to your Datatech Accounting software can be downloaded 
from Datatech’s server if you have a connection to the Internet.  The 
Tools menu has an option to Check for Updates.  When you select this 
option, the program will first check to see if there is a newer version of 
the program available for download, and then ask if you want to 
download it: 

 
If you would like to see a list of changes included in the program 
update, check the box that says “Display release notes before 
downloading” and then click on the Yes button.  You will then see a 
window listing the changes included in each version released since the 
one that you are currently running. 

You can print the changes out if you want to review them on paper, 
then click on the Download button to continue the download and 
installation of the update, or click on Cancel to close the window 
without downloading the update. 

When the program starts downloading the update, a status window will 
appear to show you the progress of the download as well as the time 
remaining: 

 
In addition to using the Check for Updates option on the Tools menu, 
you can have the program automatically check for updates on a regular 
schedule.  This is controlled by settings in the Program Setup window. 

Margin Note
\definition #1
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Save Reports as PDF Files 
All reports can be saved as Adobe Acrobat documents (PDF files).  In 
addition, you can email any report as a PDF attachment directly from 
the Print Preview window. 

To save a report as a PDF file, press Ctrl+A on the report window.  The 
program will display the Save As dialog for you to choose a filename to 
save the report as: 

 
You can also change the “Save as type” to save the report as a text file 
instead of a PDF file.  A report that has been saved as a text file can be 
opened using a text editor or word processor (such as NotePad or 
Microsoft Word) or by Microsoft Excel. 

Then run the report by clicking on the Preview or Print button.  When 
the report is done, the program will display a message to confirm that 
the report has been saved: 

 
You must of course have Adobe Acrobat Reader installed to view 
reports that have been saved in PDF format.  If you don’t have the 
Acrobat Reader software, go to www.adobe.com to download it. 

 
Emailing Reports 

Click on the email button (right next to the print button) to email a 
report as a PDF attachment.  A Send message window will appear with 
the report already attached.   

http://www.adobe.com/
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My Help 
The My Help system allows you to create and edit your own 
documentation for using the program.  You can supplement the 
standard documentation with information unique to your company, 
including procedures and policies, workflows that are specific to how 
you use the program, unique reports that you run, and any other 
supplemental information that you choose to include.  This information 
that you add is automatically organized like the built-in help system.  
Pages are both organized into a table of contents and a context-sensitive 
link is maintained to the original window that you generated the help 
page from. 

The My Help system is designed to automatically address two key 
concerns that users typically have when they are writing their own 
notes:  What menu option did I use to get to this window?  And how do 
I take a snapshot of the window I’m on? 

The options for My Help can be accessed via shortcut keys or by the 
drop down menu on the Help button on the button bar: 

 
Here is an example of how to use the My Help system:  Suppose you 
want to get a report from the payroll system of all of the employees that 
have had minimum wage adjustments to their piecework wages on their 
checks in the last month.  You call support and Damaris tells you that 
there isn’t a specific report in the system that does just this, but that the 
Labor Analysis Report is a multi-purpose report that can be used to get 
the report that you want.  She tells you how to use the report and what 
options to pick.  You want to make some notes for future reference that 
you can refer to when you or someone else in your company needs to 
run this type of report again. 

Starting on the Labor Analysis Report window, you can either press 
Alt+F1 to add a new topic to My Help, or click on the drop down menu 
on the Help button and select the Add New Topic option (see 
screenshot above).  The following window will appear: 

 
Enter a subject and a topic for the help page that you are creating.  
These entries are used to form the table of contents for your help file.  
The filename will be created automatically for you and cannot be 
edited.  Click on the Ok button and the help program will generate the 
help page for you with your topic heading, the title of the current 
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window, the path to get to that window, and a screenshot of the current 
window in the My Help Editor window: 

 
The My Help Editor is a basic editing program built into the Datatech 
Accounting Software where you can add to and edit the help pages.  
You can add both additional text and screenshots to your help page.  To 
add text after the screenshot, just scroll to the bottom of the file, click 
on the next line and start typing. 

 
To add additional screenshots to your help page, minimize the My Help 
Editor window, go to the window that you want to take a snapshot of, 
and press Alt+F2 to copy an image of the window to the clipboard.  
You can then return to the My Help Editor and paste the image into 
your help page.  This can be done either by right-clicking and selecting 
Paste from the popup menu or clicking on the Paste button in the My 
Help button bar. 
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Once you have finished your help page, click on the Save button in the 
button bar of the My Help Editor window, then close the My Help 
Editor.  Once you have saved a My Help page, it will be linked to the 
original window that it was created from.  So if you are on the Labor 
Analysis Report window and you click on the drop down arrow on the 
help button, you will be able to see a list of all of the help pages that 
you have created from that window: 

 
In addition, you can go to the main My Help option on the drop down 
menu to open the My Help window, where you can view any of the 
help pages that you have created. 
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Security 

Datatech Accounting software uses a permissions-based security 
system.  Each user is assigned a login name and password which must 
be entered before the user can gain access to the Datatech Accounting 
Software. 

By default, each user has complete access to the entire accounting 
system.  The system administrator can then deny access to specific 
areas (modules) or individual windows within the accounting system to 
either individual users or groups of users. 

In addition to general access rights (open, save, delete, create, edit) 
certain views may have additional custom permissions that you can 
grant or deny users. 

 



29 
 

Operator Setup 
Each person who will be using the Datatech Accounting software may 
be assigned a user name and password.  If you have not set up any 
users yet, the program will not ask for a user name and password when 
it is started up.  Once you have set up one or more user names, you will 
be prompted to login before you can do anything in the Datatech 
Accounting software. 

To set up your user names, go to the Tools menu and select the Setup 
Operators option.  The following window will open: 

 
The login name and password are the minimum requirements for 
setting up a user. 

Login Name 

The login name may be up to 16 letters.  Only uppercase letters are 
allowed. 

Password/Retype Password 

Enter the password, also up to 16 letters.  The password is not case 
sensitive, i.e. it doesn’t matter whether the Caps Lock key is on or 
off when you type in the password. 

As you type in the password, asterisks will be displayed for each 
letter.  Since you cannot see what you are typing in as you are 
typing it, you must retype the password in the next entry to 
confirm the password.  If the two entries do not match, the 
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program will give you a warning message and will not save the 
operator information until the passwords match. 

Employee Name 

You may enter the employee’s full name here.  This is an optional 
entry. 

Email Address 

The user’s email address can be entered for your reference.  If you 
are using the SMTP option, this email address will be used for the 
“From” field. 

SMTP Username/SMTP Password/Retype Password 

If you are using SMTP for sending emails and your server requires 
authentication, enter the username and password to use for logging 
into the SMTP server. 

Location 

If this user will be restricted to access inventory records for a 
single location, enter the 2 character warehouse location code here. 

Employee # 

Enter the employee account number for this user. 

By setting up the login names and passwords, you can control who has 
access to the Datatech Accounting system.  If you also want to control 
which parts of the system these users can access, you will also need to 
set up access permissions.  Each access permission may grant or deny 
access to a specific menu option or window, or to all of the options in 
an entire module (such as payroll, accounts payable, general ledger). 

 
Adding Access Permissions 

Each window in the Datatech Accounting system has a “view name”.  
The view name is used to identify windows on the permission list.  By 
adding views to the permission list, you can control which options each 
user may access and whether or not they can save or delete information 
from that view. 

Each view name starts with a two or three letter module ID code, 
followed by a period, then the view name.  For example 
“AR.Customers” is the view name for the Enter/Edit Customer window 
in the Receivables module. 

In addition to controlling access to specific windows, you can control 
access to entire modules, e.g. all payroll options, all general ledger 
options, etc.  This is done by adding an entry with just the module 
name.   

Module Names 
The following module names are used by the system (note that you 
may not use all of these, depending on what accounting software 
package you are using): 

• AP:  Accounts Payable 

• AR:  Accounts Receivable 

• CA:  Cost Accounting 



31 
 

• GL:  General Ledger 

• GR:  Grower Accounting 

• INV:  Inventory 

• LC:  Labor Contractor Reports 

• OE:  Order Entry 

• PE:  Pesticide Reporting 

• PR:  Payroll  

• SYS:  Program Setup  
Adding Permissions 

The grid in the bottom half the window contains the list of windows 
and modules that you want to control access to. 

 
The example above shows two lines in the permission list.  The first 
line is for the Bank Reconcilement window and the second line is for 
an entire module (payroll).  In both cases, access is denied completely 
because the Open checkbox is not checked. 

There are five different permissions that you can enable or disable on 
each view that is listed: 

Open. This checkbox determines whether or not the user can open the 
window.  If this box is not checked, the user will see the following 
message when attempting to access the window: 
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Save.  This checkbox controls whether or not a user will be able to save 
information in this window.  If this is not checked, the user can view 
information in this window, but not modify existing records or create 
new records. 

Edit.  This checkbox gives you finer control over saving information.  
It controls whether or not the user may edit existing records in this 
view. 

Create.  This checkbox allows you to control whether or not the user 
may create new entries in this window.  If it is not checked, the user 
may only edit existing records (assuming the Edit box is checked). 

If the Save box is not checked, it does not matter whether or not the 
Edit or Create boxes are checked or unchecked—no saves will be 
allowed of any type.  The Save box must be checked if you want the 
Edit and Create boxes to have any effect. 

Delete.  This checkbox determines whether or not the user will be able 
to delete records from the window. 

Additional View Settings 
In addition to the standard options of Open, Save, Edit, Create, and 
Delete, individual windows may have additional permissions that you 
can set.  These will vary from window to window.  Most windows do 
not have special view settings.  The View Settings… button will be 
disabled if the currently highlighted window does not have any 
additional permissions.  When the View Settings… button is enabled, 
you should click on it to review the additional security settings that are 
available for that window and make the appropriate selections. 

Click on the View Settings… button in the lower left corner of the 
window to open the Additional View Settings window: 

 
Up to nine different checkboxes and two different numeric entries will 
be displayed on this window.  Check the boxes to indicate what rights 
you want to assign to the user. 

As mentioned above, most windows do not have Additional View 
Settings.  In most cases, additional view settings are added based on 
user requests.  So if there is a particular operation or feature that you 
want to be able to control access to within a specific window, please 
talk to a customer support representative about adding the option. 
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Security Settings for Groups 
Permissions may be assigned to groups of users as well as individual 
users.  This is done by assigning users to a group and defining the 
access rights for that group.  By assigning access rights to a group, you 
only need to set the access list up once.  In addition, if you need to 
make changes or additions, this will automatically affect all users in 
that group immediately. 

There are several situations where using groups is useful.  For instance, 
you may have several salespeople that you want to be able to access the 
Order Entry module, but not any other part of the system.  Or you may 
want to restrict access to the payroll system for all employees except 
the person who does the payroll. 

To assign an operator to a group, enter the group name on the Operator 
Setup tab.  You may click on the lookup button or press [F4] to select a 
group from the lookup. 

Click on the Groups tab in the Setup Operators window to set up your 
groups. 

The permission list is set up in exactly the same way as permissions for 
individual Operators. 

 
In this example, the group “EVERYONE” is denied access to the 
payroll module. 

EVERYONE Group 
Each user may be assigned to a single group.  In addition to this, all 
users automatically belong to the group called “EVERYONE”.  That 
means if you set up permissions for the EVERYONE group, you do not 
need to enter “EVERYONE” for the group on the Operator Setup tab.  
If you set up other groups, for instance, “SALES” and 
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“ACCOUNTING”, you need to select the group name on the Operator 
setup tab to assign a user to that group. 

Keep in mind that a user that is assigned to the SALES or 
ACCOUNTING group is still a member of the EVERYONE group.  
Settings from both groups will affect what program options the user is 
able to access. 

How Permissions Are Applied 
Access permissions may be assigned at any of three different levels.  
They may be assigned to the EVERYONE group, to the group a user is 
assigned to, and to the user.  How does the system resolve conflicts, for 
instance when the user is assigned different permissions for the same 
module than the group that that user is assigned to? 

The following rules are applied to determine which rights a user 
actually has.  First, all permissions from the group EVERYONE is 
applied.  Then if the user is assigned to a group, all of the settings for 
that group will override settings for the EVERYONE group.  Finally, 
any settings set up for the user will override settings both for the user’s 
group and the EVERYONE group. 

At each level, the program first checks to see if there is a permission 
entry for the individual window.  If an entry is not found, it will check 
to see if there is an entry for the module that the window belongs to. 

The entries at the user level are checked first, then the entries at the 
group level are checked (if the user is assigned to a group), then the 
entries for the EVERYONE group are checked. 
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Security Basics 
As the system administrator, you should grant yourself complete access 
to the Operator Setup window (view name: SYS.OperatorSetup) . Then 
to secure user settings, it is a good idea to restrict access to the Operator 
Setup window at the EVERYONE group level.   

What this will do is deny access to the Operator Setup window to all 
users, except you.   Obviously, if a user can get into the Operator Setup 
window and make changes, the system is not very secure; users could 
eliminate access restrictions and grant themselves more rights. 

Next you should decide if there are any areas of the system that in 
general, you do not want anyone to access unless you have explicitly 
granted access.  For instance, it is common to restrict access for all 
users to the Payroll and General Ledger modules. 

Remember that by default, all users have access to all program options.  
If you want to change this so that by default, all users cannot access any 
options, then you could set up the permissions on the group 
EVERYONE so deny access by default.  Since this can be done on a 
module basis, you would only need to make a few entries in the 
permissions list to do this. 

You could then set up other groups that grant access to certain parts of 
the software.  For instance, you could have groups for Salesman, 
Payables, Payroll, and Receivables.  Then each user could be assigned 
to one of these groups, depending on which area of the program they 
need access to. 

If a certain user needs access to more options than are included in the 
group he or she is assigned to, you can add these extra settings to the 
individual operator permissions. 
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Restricting Access to Employee Accounts 
In some situations you may want to restrict access to certain employee 
accounts to limit access to sensitive payroll information.  This might 
include payroll accounts for owners/officers/management.  You may 
want to restrict users that are performing general data entry and check 
printing for all other employees.  One or more users may be granted 
access to the sensitive payroll accounts to perform the check 
entry/printing. 

There are two ways to control access to sensitive payroll accounts.  
Both involve adding the “PR” module to the user or group security 
settings: 

 
After adding the PR line to the security settings, click on the View 
Settings… button to open the Additional View Settings window.  The 
first (and simplest) option to restrict access are the two checkboxes at 
the top of the window that control whether or not the user can view/edit 
salaried employees and 941 employees. 

By default, these boxes will be unchecked, so you must check them for 
any operator that will need to access salaried and 914 accounts. 

In some cases, these checkboxes may not provide you with fine enough 
control over which operators can access which employee accounts.  In 
this situation, you can enable the Employee Access Security levels 
feature.  To do this, go to Tools->Program Setup->Payroll->Settings 
and check the Security Levels box: 
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Restart the program for this setting to take effect.  After restarting, you 
will see a Security Level entry at the bottom right corner of the 
Employee setup window. 

By default, all employees are assigned a security level of zero, and all 
operators are assigned a security level of zero.  To restrict access to a 
particular employee account, simply assign it a higher security level.  
An operator must be assigned a security level equal to or higher than 
the security level assigned to the employee account. 

For instance, suppose you assign management employees a security 
level of one, and corporate officers a security level of two.  You can 
then assign one or more operators a security level of one, and they will 
be able to access all regular employees and all management employees, 
but not the corporate officer accounts.  You can assign a security level 
of two to the operator that handles the payroll for the corporate officers, 
and this operator will be able to access any employee record. 

To assign a security level to an operator account, add the “PR” module 
entry on the security settings grid as shown above, click on the View 
Settings… button, and enter the security level at the bottom of the 
window. 

Payroll Information in Other Modules 
The “PR” module setting automatically applies to all payroll options.  It 
will limit access not only on data entry windows, but also on the 
reports.  For instance, an operator with a security level of zero can print 
a Payroll Journal, but the report will only include employees that are 
assigned a security level of zero. 

In other parts of the system, payroll information is normally displayed 
and you may not want users to be able to see the names and amounts.  
The security level is automatically applied to other options in the 
system, including the following: 

• Checkbook Register  

• Check Register Report 

• Check Journal 

• Bank Reconcilement Entry/Report 
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• Review Journal Transactions 

These program features (whether it is on screen on or a report) will not 
show the name of employees that have a security level higher than the 
security level assigned to the operator, as shown below: 

 
While the name does not appear, the check #, date, and amount of the 
check will appear. 

Additional security options are available on these individual options 
that restrict access to all payroll checks.  For instance, on the 
Checkbook Register security settings, an option is available to turn off 
access to all payroll checks: 

 
When the View Payroll Checks box is not checked, all payroll 
transactions are hidden completely on the Checkbook Register window. 
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Getting Started 

As with any accounting system, some initial setup work is required to 
use The Farmer’s Office.  Here are some of the files that are involved 
in the setup work.   

• General Ledger Chart of Accounts 

• General Ledger Starting Balances 

• Cost Centers 

• Job Codes 

• Employee Account Setup 

• Vendor Account Setup 

If you are currently using 
another farm accounting 
system, much of the initial 
setup work can be 
eliminated by importing 
information from your 
current system.  Data can 
be imported from AgData’s 
Blue Skies, Frontier’s DOS 
and BizBooks Windows 
programs, and Famous 5.8.  
Contact Datatech customer 
support for more details 
and instructions for 
importing your data. 

The extent of the setup work you'll need to do may depend on your main goals 
in using The Farmer’s Office, your personal preferences, and whether you are 
just evaluating the software or purchased the software and getting everything set 
up for the first time.  

For instance, some people may like to have all their current vendors set up 
before they write checks, others may want to enter vendors "on the fly" as they 
enter checks.  Here are a few questions to help you determine the extent of your 
start up work: 

Do you need to start writing checks to vendors immediately?  To write checks, 
you'll need to have your bank accounts set up (which may have already been 
done by the initial installation wizard) and vendor accounts entered.  You can 
enter vendors as you write checks to them if you want, or you can set up all 
vendor accounts ahead of time.  Setting up the beginning balance for your bank 
account is also a good idea so that you'll have an accurate bank balance as you 
write checks.  The beginning balance is also necessary to use the Bank 
Reconcilement feature. 

Do you need to get payroll going now?  Employee accounts need to be 
set up before writing payroll checks.  In addition, if you are starting in 
the middle of the year, the employee year-to-date totals must be 
accurately entered or else you may have problems with taxes.  If you 
have garnishments or other non-tax deductions, these will need to be 
set up on employee accounts. 

Do you want to get cost accounting reports?  In this case, be sure to set 
up both your cost centers and your expense categories to produce the 
information you'll need.  Cost centers normally correspond to the 
physical location (field, vineyard, orchard) and crops you grow.  For 
example, you might want your general ledger reports to show one total 
amount for labor.  On the cost accounting reports, however, you want 
to see totals for different categories of labor.  If you would also like to 
see a breakdown of the Cost Center expenses by Job, you’ll need to set 
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up Job Codes.  Job codes basically act as a sub-category for general 
ledger accounts, and are only used for cost accounting reports. 

Do you want to be able to get accurate financial statements?  In order to 
get accurate financial statements you'll need to enter the starting 
balances for your current fiscal year to get your balances up to date. 

If you are not too concerned about getting reports for your current year, 
you can skip the step of entering the starting balances.  However, you 
may want to enter at the very least your starting balance for your bank 
account(s) so that the program will be able to calculate your current 
bank balance and you'll be able to do a bank reconcilement.  At the end 
of the fiscal year, enter adjusting entries according to your accountant’s 
figures to get your books to match his.  From that point forward, your 
reports will be up to date. 

To print an activity report 
for your accountant (also 
sometimes called a G/L 
Detail Report) go to the 
General Ledger menu and 
select the Update option.  
This will produce a report 
that shows the beginning 
balance for each account, 
all of the transaction 
posted to that account, and 
the ending balance for the 
account. 

At the end of the year, most of our customers provide their accountants with a 
detailed report showing all activity in the general ledger.  In most cases, they set 
up their Chart of Accounts to substantially match the Chart of Accounts that 
their accountant uses.  The Farmer’s Office comes with a Chart of Accounts 
built in that you can use or modify to suit your needs.  Modifying this Chart of 
Accounts takes very little work compared to starting over from scratch. 
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General Ledger 
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The Chart of Accounts 
Introduction 

The Chart of Accounts is the heart of the financial reporting system in 
The Farmer’s Office.  It defines categories for your assets, liabilities, 
capital, income, and expenses.  Expenses in particular need to be set up 
to give you the breakdown you want to track expenditures on both 
profit and loss statements (in the general ledger) and crop reports (for 
cost accounting). 

A sample Chart of Accounts is provided with The Farmer’s Office.  
You may use this as is, modify it, or replace it completely with your 
own chart of accounts.  Many users set up their Chart of Accounts to 
mirror the one used by their accountants, to make it easier to provide 
information to the accountant at the end of the year as well as to keep 
their numbers up to date with adjusting entries from the accountant. 

Each entry in the Chart of Accounts has an account number, which may 
be up to 6 digits, with a 2 digits decimal sub-account.  The sample 
Chart of Accounts that is provided uses 3 digit account numbers. 

The chart of accounts is divided up into several main sections.  We 
have listed the account numbers used in the sample Chart of Accounts 
for each of the sections below: 

Assets:  100 to 299 
Assets are those items the business owns.  These may include cash in 
bank accounts, receivables, stocks, or fixed assets such as land, 
equipment, buildings, pipelines, and plantings.  Assets are divided up 
into two categories: Current Assets and Fixed Assets. 

Liabilities:  300 to 399 
Liabilities are those obligations the business owes to others, such as 
payroll taxes, accounts payable, and loans payable. 

Capital:  400 to 499 
Capital or Owner's Equity is what the business is worth, or to put it 
another way, what the business owes you, the owner. 

Income:  501 to 599 
Income from business operations is credited to the income accounts.  
This may include crop income, patronage dividends, interest income, 
rent income, custom farming income, etc. 

Expenses:  600 to 899 
Expenses incurred by business operations are charged to the expense 
section.  Generally, there are two types of expenses: direct crop 
expenses and overhead expenses. 

Direct crop expenses are generally charged to a specific crop or field.  
These expenses would include labor costs, such as pruning, harvesting, 
tractor work, cultivation, as well as inputs or other supplies such as 
chemicals, pump repairs, electricity, seed, labor contractor costs, vine 
stakes, paper trays, etc. 
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Overhead expenses are normally not charged to a specific crop or field.  
They are also called General and Administrative Overhead.  Examples 
include accounting and legal fees, office rent, telephone, auto, and 
equipment operating or repair costs. 

In some cases, you might have additional sub-sections under Expenses.  
For instance, if you have a combination dairy-farming operation, you 
might want to have a section titled Dairy Operating Expenses.  Or if 
you are developing a new vineyard or orchard, you would probably 
want to set up a separate section titled Capital Expenditures to keep 
these expense separate from your other operating expenses. 

Chart of Accounts Printout 
It is relatively easy though to modify the existing Chart of Accounts 
that is provided with The Farmer’s Office.  This tutorial will show you 
how to modify account descriptions, add new accounts, and delete 
accounts you do not need. 

(It is beyond the scope of this tutorial to cover creating an entirely new 
Chart of Accounts from scratch.  If you want to do this, contact 
Datatech's customer support personnel and we can assist you.) 

It will be helpful to have a printed copy of your chart of accounts to 
look over and make notes on before you make any changes.  On the 
General Ledger menu, select the Chart of Accounts option.  The Chart 
of Accounts window will open: 

 
Click on the Print button at the bottom left corner, and the Print Chart 
of Accounts window will open: 
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There are three different types of printouts of the Chart of Accounts.  
For our purposes right now, the Formatted option is best.  Click on the 
Formatted radio button.  If you have more than one printer, click on the 
Print Setup button to make sure the correct printer is selected.  Click on 
the Print button to print the report out.  The default Chart of Accounts 
will print on four pages.  Close the Print Chart of Accounts window 
when the report has printed. 
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Changing the Chart of Accounts 
As you look at the printout, you may notice things that you want to 
change.  For instance, on the first page, there are five bank accounts 
with generic descriptions (accounts 101.1 to 101.5).  You may want to 
put in the name of your bank on these accounts.  Or you may have a 
partnership instead of a sole proprietorship, and need to set up owner's 
equity accounts for each partner in the Capital section.  Or you may see 
labor descriptions under Direct Crop Expenses that you don't need and 
that you can delete.  We'll cover each of these situations: 

Modifying Account Descriptions 
If you do not already have the Chart of Accounts window open, open it 
by click on the General Ledger menu and choosing the Chart of 
Accounts option. 

The cursor will start on the Account # entry.  The account number 
determines the order in which accounts print on financial reports.  
(Normally, all account numbers have the same number of digits.) 

First let's try changing a description on an existing bank account in the 
Asset section.  Of course, first you'll need to display the account 
information so you edit it.  One way to do this is to click on the lookup 
button. 

When you click on the lookup button, a selection list will appear for 
you to select a general ledger account: 

 
Selection lists can be 
helpful to use but there are 
faster ways to work with 
the program. The selection 
list is useful if you don't 
remember the account 
number that you want to 
edit, and need to browse 
through your Chart of 
Accounts to find it. But if 
you know that you want to 
edit account 101.1, you can 
simply type this in the 
Account #: entry on the 
Chart of Accounts window 
and press [Enter]. 

When the selection list is displayed, you can click on the Ok button to select the 
account which is currently highlighted, click on the Cancel button to close the 
selection list without selecting an account, or double click on an account that is 
listed to select it for editing.   

You can also click on the scroll bar to move through the chart of accounts.  
Clicking above or below the scroll bar "thumb" will display a page of accounts 
before or after those currently listed.  You can also click on the "thumb" and 
drag it to the top or bottom to go to the beginning or end of the Chart of 
Accounts.  In addition, clicking on the arrows will move the highlighted line up 
or down. 

Once you have selected an account to edit, either by double clicking on it or 
clicking on the Ok button, the selection list will disappear and the account 
information will be displayed.  For the purposes of this example, select account 
number 101.10. 
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You'll notice that if you 
press [Tab] or [Enter], the 
entire contents of the 
Description entry will be 
highlighted.  But if you 
click with the mouse 
pointer, you'll just see the 
cursor blinking in the 
Description entry.  What's 
the difference?  With the 
entire contents highlighted, 
if you type anything, it will 
replace what is there.  
When the cursor is simply 
blinking, you can use the 
arrow keys to move 
around, edit, delete, 
highlight text manually, 
etc.  If you haven’t noticed 
this already, this is how all 
Windows programs work. 

 

Suppose you want to change the description to something other than "Bank 
Account #1".  The cursor should still be in the Account # entry.  You can either 
click with the mouse pointer in the Description entry field, or just press [Tab] or 
[Enter]. 

If you pressed [Tab] or [Enter], you can now just type in your own description, 
for instance "Bank of America Checking" or "Cal Fed" or just "Checking 
Account". 

If you clicked with the mouse, you can use the backspace key to wipe out the 
description and then type your own, or use [Shift]+[Home] to highlight the 
contents of the Description entry and then type your own description. 

Don't worry about all of the other settings on this window.  After changing the 
account's description, you need to save your change.  There are several ways to 
do this: 

• Click on the Save button at the bottom of the window. 

• Press [Ctrl]+[S] (this is indicated by the "S" underline on the Save 
button) 

• Click on the Disk icon on the toolbar (the Save button). 

• Right-click on the Description entry field, and select Save from the 
popup menu. 

• Click on the File menu, and select Save. 

• Press [F2] (this is the shortcut indicated on the File, Save menu 
item). 

When you tell the program to save your change, it will confirm that you 
want to save (this confirmation can be turned off if you get tired of it), 
then save the change and clear the entry window so that you can enter 
or edit another account. 

Go ahead and try editing the descriptions on other accounts before 
continuing if you want to get more practice. 

Adding Accounts 
If you do not already have the Chart of Accounts window open, open it 
by clicking on the General Ledger menu and choosing the Chart of 
Accounts option.  Here is an example of adding a Liability account: 

Click on the lookup button on the Account # entry (you can also press 
the [F4] key to get the lookup).  On the selection list, scroll down until 
you get to the Liabilities section, and you can see account #302, Notes 
Payable. 

Suppose you have several Notes Payable and you want to keep track of 
them with different accounts.  The first thing we'll do is clone the 
existing Note Payable account, to provide as many accounts as you 
need. 

From the lookup select the Notes Payable account.  The Notes Payable 
account will now be displayed in the Chart of Accounts window: 
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Now press [F5] (this is the clear key--you could also click on the Clear 
button at the bottom of the window).  Notice that the Account # and the 
Description entries disappear, but the rest of the settings remain.  Now, 
you can type in your own account number and description for a new 
account. 

First, you have to decide what account number to use.  If you expect to 
add just a few notes payable accounts, you could number them 303.00, 
304.00, 305.00, etc.  Or, you might want to number them 302.01, 
302.02, 302.03, etc.  It doesn't matter to the program which numbers 
you use.  So does it really make a difference?  You may have noticed 
on the selection list that there is already an account number 310.00...so 
if you number the accounts 302, 303, 304, etc. you can only go up to 
account 309 (that is of course if you are going to keep and use account 
number 310).  On the other hand, if you number the notes payable 
accounts using the decimal extensions, .01, .02, .03, etc, then you'll 
have room in that sequence for 99 account numbers.  So it really just 
depends on how many accounts you need right now, and how many 
you anticipate you might add in the future. 

Once you have your account number entered of course, the description 
is next.  At this point, you can save your new account (press [F2], click 
on the save button, etc.). 

Title and Total Accounts 
You may have noticed that in the Asset section, there is an account 
called "Cash in Bank" (account #101.00).  There is also an account 
called "Total Cash in Bank" (account #101.99).  Continuing with the 
example of adding additional Notes Payable accounts, let's suppose that 
you want to add similar accounts in for your Notes Payable. 

Account 101.00 is a Title account.  That means it simply exists as a title 
for a series of accounts that follow.  It cannot be used for posting 
transactions; it is simply printed on financial reports as a way of 
making them more readable and understandable. 
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In our example, let's suppose that you are numbering your individual 
notes payable with the numbers 302.01, 302.02, 302.03, 302.04, etc.  In 
this case we'll make 302.00, the existing Notes Payable account, the 
title account, and we'll set up a new account, 302.99, as the total 
account. 

First, you'll need to bring up account 302.00 on the Chart of Accounts 
Window.  Click on the Account Type entry, and select Title instead of 
Posting.  Then save the account. 

Usually, when you have a title account, a series of posting accounts, 
and then a total account, the posting accounts are indented an extra 
level.  This is another feature used for making financial reports more 
readable.  (You can see the indentation of the account names on the 
Chart of Accounts selection list, by the way.) 

The Tabs entry is what controls the indentation level for printing 
financial reports.  So on your individual notes payable accounts; you 
would want to change the setting on the Tabs entry from 1 to 2. 

Another setting we need to change is the Total Level.  Because we are 
going to add a sub-total after all of the notes payable account, we need 
to reduce the total level setting from 3 to 2 on each individual Notes 
Payable account. 

Now it's time to create the Total account.  Enter the account number 
(302.99), an appropriate description ("Total Notes Payable" is probably 
good), select "Total" for the Account Type setting, 2 for the Total 
Level, and 1 for the Tabs setting. 

If you've been able to follow everything so far, you may have figured 
out the best order for making these changes: 

1. Clone account 302.00, creating account #302.01, 
changing the Tabs and Total Level settings in the process. 

2. Edit account 302.00, changing it to a Title account. 

3. Clone account 302.01, to create as many posting accounts 
as you need. 

4. Create account 302.99 to total all of the notes payable.  

As you might guess, cloning existing accounts can be used on any type 
of account.  The real key to cloning an account is to make sure you are 
starting with the right kind of account (you would not want to start with 
an Asset account for instance, and clone it to an account number that 
belongs in the Income section).  It's normally best to clone an account 
that is adjacent (or at least close to) the new account you are creating. 

Deleting Accounts 
As you review the Chart of Accounts, you may see some accounts that 
you don't need.  You can delete any unnecessary accounts.  But you do 
need to be careful, because some accounts you may not think you need 
are actually necessary for the normal operation of the program.  (For 
instance, you may not think you need the payroll tax liability accounts 
in the 350's.  However, the program needs these accounts to keep track 
of your current payroll taxes due.) 
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You may find some expense accounts in the 600's and 700's that you 
don't need.  For instance, account 704.00 is Advertising; if you don't do 
any direct advertising or have any advertising assessments; you can go 
ahead and delete this account.  Or, if you don't grow raisins, the 
accounts in the 600's for Rolling and Tray Turning will not be 
necessary.  You might change these accounts to different labor 
descriptions, or you could simply delete them. 

To delete a general ledger account, first select it for editing as described 
in the previous help pages.  With the account information displayed in 
the Chart of Accounts window, you can delete it by doing any of the 
following: 

• Click on the File menu, and select Delete. 

• Press [Shift]+[F2] (the shortcut displayed on the File, 
Delete menu option.) 

• Click on the Delete button at the bottom of the Chart of 
Accounts window. 

• Press [Ctrl]+[D] (the shortcut indicated by the underlined 
"D" on the Delete button). 

• Right click on the Account # entry and select Delete from 
the popup menu 

• Click on the Delete button on the toolbar: 

One thing to keep in mind is that you can't delete an account that has 
been used in a transaction.  The program will give you a warning 
message if you try this.  This would leave transactions in the program 
without a valid general ledger account number.  Normally you won't 
have this happen when you first start out, so you usually don't need to 
worry about that. 

 
Figure 1 - The Delete button on the toolbar can be used to delete the record 
that is currently displayed in any window. 
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Starting Balances 
Starting balances only need to be entered once when you first start 
using your Datatech Accounting Software.  Starting balances for 
succeeding years are carried over from the prior fiscal year.  To open 
the Enter/Edit Starting Balance window, go to the General Ledger 
option on the main menu, then go to Transactions, and select the 
Starting Balances option.  The following window will appear: 

 
There are four different entries you make on each line: 

Date 

Enter the transaction date for the starting balances.  Normally the 
date for starting balances will be the first day of your fiscal year.  
Each entry should use the same date. 

G/L # 

Enter the general ledger account for this entry.  You can press [F4] 
or click on the column heading to get the general ledger account 
selection list. 

When you enter or select a general ledger account, the description 
of the account will be displayed at the bottom of the window. 

Description 

Entering a description is optional.  In general, you may just want to 
enter "Starting Balance".  This description will appear on 
transaction reports and the general ledger update report. 

Amount 

Enter a positive number for a debit balance or a negative amount 
for a credit balance.  As you enter the balance for each account, the 
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total at the bottom of the window will be updated.  When the Total 
shows zero, the beginning balance entries are in balance. 

 

You can print a report listing your starting balances by clicking on the 
Print button at the bottom right corner of the window.  (Notice that the 
"P" in Print is underlined.  That means you can also hold down the 
[Ctrl] key and press [P] at the same time to print the report.  This is a 
"shortcut key".) 

It is a good idea to print your starting balances after entering them to 
make sure that the entries balance.  That is, the debits and credits must 
equal.  At the end of the report, separate totals will be printed for both 
debits and credits. 

General Ledger Starting Date 
The Startup Wizard will automatically set the starting date for the 
General Ledger to the first date in your current fiscal year.  This is the 
date that it will use by default for your starting balances. 

For instance, if you install the program in June and tell the program that 
your fiscal year ends in December, the G/L Starting date will be set to 
January 1 of the current year.  If you are not going to enter your 
transactions for the prior months going back to the beginning of the 
year, then you will want to change the starting date.  Supposed you are 
going to enter your starting balances as of July 1.  In this case, July 1st 
should be your G/L Starting Date. 

To change the G/L Starting Date, go to the Tools menu, select Program 
Setup, then click on the General Ledger button at the top of the 
Program Setup window.  In the Fiscal Year Settings group, enter the 
starting date that you want to use. This is highlighted in the screenshot 
below. 
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Starting Balances for Payables and Receivables 
This section includes 
advanced information 
about setting up your 
starting balances for 
Accounts Payable and 
Accounts Receivable.  If 
you are on a cash basis, or 
otherwise don’t have open 
payables and receivables 
balances when you start 
using The Farmer’s Office, 
you can ignore this 
information. 

There are two general methods for handling balances in your accounts payable 
trade and accounts receivable trade accounts.   

The first method is to handle everything through the general ledger.  Your 
starting balances of course will include everything that you owe to your vendors 
and everything that your customers owe to you.  We recommend setting up 
separate accounts for your payables and receivables balances that are carried 
over from your prior system.  For instance, if you are switching from 
Quickbooks, instead of having a single “Accounts Payable Trade” account that 
includes the balance from your prior system and is used as well for new 
payables that are entered in The Farmer’s Office, you would have an “Accounts 
Payable Trade” account for new payables and an “Accounts Payable Trade 
Quickbooks” where your starting balance would be posted to for amounts owed 
to vendors.  Then when you pay a vendor invoice that was originally posted 
through Quickbooks, you would write a direct expense check and use the 
“Accounts Payable Trade Quickbooks” liability account.  This will reduce the 
total liability in that account. 

 

Once all of the invoices that were entered in Quickbooks are paid off, 
the balance in the “Accounts Payable Trade Quickbooks” account will 
reach zero.  If it does not, this is an indication that either not all of the 
invoices were paid, or the starting balance in that account was 
incorrect. 

If you issue invoices to customers, a similar approach can be used for 
your receivables.  Create an “Accounts Receivable Trade Quickbooks” 
account, and when you receive payments from customers for invoices 
that were issued from Quickbooks, you would simply enter a 
miscellaneous cash receipt and credit the income to that account. 

Using this approach keeps the work you need to do to a minimum.  But 
it does have some limitations.  What if you want to issue a check to a 
vendor to pay invoices that were posted in Quickbooks as well as new 
invoices that were entered in The Farmer’s Office?  The only thing you 
can do is issue two checks: first, a direct expense check to pay the 
invoices issued through Quickbooks, then a payables check to pay the 
invoices issued in The Farmer’s Office. 

Similarly, if you receive a check from a customer paying invoices that 
were issued through Quickbooks and invoices issued through The 
Farmer’s Office, you’ll need to make two separate entries in Cash 
Receipts: a miscellaneous cash receipt and a receivables cash receipts. 

After reading this 
information, you may find 
it helpful to come back and 
review this section after 
learning more about how 
the payables and 
receivables modules work. 

You may find it makes more 
sense then! 

This leads to the second approach:  entering all of your open items into the 
Accounts Payable and Accounts Receivable systems.  This is obviously more 
work, because you’ll need to enter all open invoices for each vendor accounts 
and all unpaid invoices for your customers.  But it has the advantage of 
simplifying your job when writing vendor checks or receiving payments from 
customers.   This is because all open items will be in your system, whether they 
were originally posted through your previous program or whether they were 
entered in The Farmer’s Office. 

If you’ve been following everything so far, you may be wondering how entering 
your open invoices will affect your starting balances in the general ledger.  
Won’t posting invoices to vendors duplicate your accounts payable balance as 
well as expenses that are entered through the general ledger starting balances?  
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The answer is that they will, unless you use the G/L Starting Date to create a 
“cutoff” for accounting balances. 

 

Suppose you are starting up with The Farmer’s Office on July 1st, the 
middle of your fiscal year.  You can enter 7/1/2007 as your G/L 
Starting Date, and the program will ignore any transactions posted prior 
to that date.  This means that if you enter vendor invoices date prior to 
7/1, it will create open items in the payables system but the balances 
that result from those transactions will not be carried forward.  July 1st, 
all account balances start at zero.  Your starting balances will be dated 
7/1/2007 and include balances for assets, liabilities, capital, income and 
expenses.   

You will need to make sure that the starting balance that you enter for 
your Accounts Payable Trade account from your prior program 
matches the total of invoices dated prior to your starting date.  For 
example, you would run an Aged Accounts Payable Report as of 
6/30/2007 and the total of the invoices on this report should equal the 
starting balance you entered for Accounts Payable Trade. 

The same thing applies to accounts receivable.  You would run an Aged 
Accounts Receivable Report for 6/30/2007 and the total of this report 
should equal your beginning balance for Accounts Receivable Trade on 
7/1/2007. 
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General Ledger Configuration 
Settings 

On the Settings tab, you may need to update the G/L Starting Date to 
the date you will first begin using Datatech software. 

 
Account Numbers 

On the Account Numbers tab, enter your G/L #’s for the respective 
entries.  If you are using the Default Chart of Accounts, included with 
the software installation, you may not need to change these accounts. 
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Labor Contractor Reference 
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Grower Entry 
An account must be set up for each grower you perform work for.  
Each grower account has settings which control how the grower is 
billed for labor.   

If you are using the optional Accounts Receivable system, each time 
you enter a new grower, a corresponding account will be created in the 
customer file (and vice versa).  And if you make changes to a grower 
account (name/address/phone #'s), then the corresponding customer 
account will be updated with the same changes.  Because of this, your 
grower file and your customer file should mirror each other as far as the 
names/addresses/phone numbers. 

To set up grower accounts, go to Labor Contractor->Growers option. 

 

 
Account # 

Enter an account number for the grower.  To edit an existing 
grower account, type in the account number or click on the lookup 
button. 
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Name Key 

Enter an abbreviation of the grower name to be used to alphabetize 
grower accounts. 

Name 

Enter the actual name of the grower. Either personal or a company 
name. 

Additional Name 

An extra area for additional Name information. 

Mailing Address / City / State / Zip 

Enter the grower's full mailing address n these boxes. 

Street Address / City / State / Zip 

If different from the mailing address, enter the grower’s street 
address.  If entered, the street address will be printed on the payroll 
check stubs instead of the mailing address. 

Phone #1 / Phone #2 

You may enter two phone numbers for each grower. 

Min. Piece Rate/Hour 

Enter the minimum hourly rate that employees working for this 
grower should be paid when they are paid using a guaranteed rate 
wage type.   This entry is optional, but it should be used if you 
have different guaranteed hourly rates for different growers. 

Guaranteed wage adjustments will be calculated using the higher 
of 1) this rate, 2) the employee’s hourly rate (if entered) or 3) the 
minimum hourly rate specified by the pay rate table.  

Min. Hourly Pay Rate 

Enter the minimum hourly rate that employees working for this 
grower should be paid when they are paid using a straight hourly 
wage type (e.g. regular hours, overtime, and double time).  This 
entry is optional.  

If you enter a rate here, it may be used as a default rate during 
check entry. (Whether or not this rate is used depends on whether 
you have set a different default rate elsewhere.)   

Union 

If this grower is part of a union, check this box. 
Labor Reports/Invoicing 

Labor Report 

The default option is to print both the gross wages and the 
employee recap sections on the Grower Labor Report.  You have 
the option of selecting the employee recap section only, or not 
printing a grower report at all. 

Print Harvest Totals on Report 

Check this box if you are going to enter harvest totals for the 
grower account and want the Grower Labor Report to print the 
Harvest Analysis section. 
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If you are using the cost accounting module, you may enter harvest 
totals for the grower account but not want them to appear on the 
Grower Labor Report.  In that case, do not check this box. 

Print Grower Invoice After Report 

Check this box if you don’t want the generic grower invoice to 
print after the labor report.  It may not be necessary to print this 
invoice if you are updating invoice to Accounts Receivable and 
printing the invoices from A/R. 

Print Full S. S. # on Labor Reports 

This option is checked by default and determines whether or not 
the employees’ full Social Security Number is printed on the 
Grower Labor Reports.  This is a requirement under Federal law 
(MSPA) and may be required by state law (e.g. is it required also 
by California law). 

If you have customers that you provide workers for that are not 
covered by the MSPA or relevant state law, you may uncheck this 
box to suppress printing the employees’ Social Security Numbers 
on the Grower Labor Report. 

Generate Report 

This setting controls when the Grower Labor Report data will be 
generated.  The default setting is to generate the labor report data 
after the Payroll Journal report has been updated.  You also have 
the option of generating report data when the Create Checks option 
is used from the Daily Payroll. 

When the Create Checks option is selected, you will be able to 
print the Grower Labor Report and generate an invoice 
immediately after you use the Create Checks option.  However, 
there are some disadvantages to using this method: 

Check data can be edited after checks have been created.  Because 
of this, if you make corrections or additions using the Batch Check 
Entry window, the Grower Labor Report may not contain accurage 
information. 

Additionally, since checks have not yet been printed, the Grower 
Labor Report will not print a check number in the Employee Recap 
section. 

Billing Method 

Select the billing method you want to use for this grower: 

Cost+Comm %: The grower will be billed for the labor plus the 
commission rate(s) specified in the Billing Information section 
below.  Use this option is you charge a flat commission or if you 
bill for individual employer taxes plus a commission. 

Fixed Rate:  Use this option if you pay the employees one rate per 
hour or unit and bill the grower a different rate.  The grower is 
billed a flat rate for labor performed, based on the amounts in the 
Pay Rate file.  The Pay Rate file allows you to set different billing 
rates for different growers, fields, and jobs. 

Fixed+Comm %:  This option is a combination of the prior two 
methods.  The grower is billed a flat rate for labor performed, 
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based on the amounts in the Pay Rate file, plus a commission rate 
specified in the Billing Information section. 

Costs+Workers:  This option will bill for labor, taxes and 
worker’s comp plus a fixed amount for the total number of days 
worked (entered in the first billing description) and a fixed amount 
for the total number of workers (entered in the second billing 
description). 

None:  No invoice will be printed after the Grower Labor Report. 

Update A/R 

This setting controls whether or not an invoice is automatically 
created in the optional Accounts Receivable module, and at what 
point it is created.  If you are not using the Accounts Receivable 
system, then this setting will have no effect. 

Select From Labor Reports to have the program create an invoice 
when the Grower Labor Report is printed and finalized.  This is 
done after checks have been printed and the Payroll Journal has 
been updated.  This is the default option. 

Select From Create Checks if you are using the Daily Payroll 
Entry window and want to create an invoice when you use the 
Create Checks option.  Because checks have not been finalized at 
this point, it is possible the check information may be edited and 
the grower invoice information could become inaccurate.  In this 
case, you would need to edit the invoice yourself to reflect changes 
or corrections to.  However, because the grower invoice is created 
earlier in the workflow, you are able to produce an invoice and 
deliver it to the grower before you have printed checks for the 
employees. 

Select No if you are entering the invoice yourself or doing the 
billing manually. 

Invoice Update 

This controls the status of invoices created in receivables.  The 
invoice status may be either Trial, Final, or Batch Print.  A final 
invoice will appear immediately on the receivables report and sales 
journal.  Updating an invoice as a Trial or Batch Print will allow 
you to edit it before finalizing it, so invoices will not appear on the 
receivables report and sales journal until you finalized them in the 
receivables system. 

The Trial option is recommended if you will be finalizing invoices 
one at a time in the receivables module.  If you want to print and 
finalize invoices together, use the Batch Print option. 

# of Invoices: 

This entry controls how many invoices are generated for each 
grower for each run of the grower labor reports.  The default is 
One Invoice per grower.  The one invoice may include work done 
at different crop/fields/ranches/locations but all under the same 
grower account. 

You can also choose to generate one invoice per crop/field/location 
with the One Invoice per Crop option.  This will group multiple 
jobs performed at the same location together on one invoice. 
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If your grower wants one invoice per ranch, but needs subtotals for 
each field on that ranch, use the One Invoice per Ranch setting.  
For this setting to work properly, you must enter the ranch name in 
the Description column for each field.  Then enter the field 
number, name or commodity in the Commodity column.  Be sure 
that the Crop ID numbers that you assign for each field within a 
ranch are consecutive, and that the ranch name matches exactly for 
each of the crop entries on that ranch. 

The One Invoice per Crop/Job option will generate a separate 
invoice for each job performed at each crop/field/ranch/location. 

The One Invoice per Crew option will create a separate invoice for 
each crew that worked for a single grower. 

Update Line Items 

Twelve different options are available for generating the lines 
items for the invoices created in Accounts Receivable: 

General Invoice. This option will create a single line item for each 
job/crop/wage type/rate combination.  These line items mirror 
those listed on the grower invoice printed by the labor reports 
program.  Invoices generated with this type must be edited in the 
general invoicing window. 

General Invoice/Crop, Date. This option will create invoices that 
itemize labor for each crop/day/crew/job/wage type/rate 
combination.  This produces a more detailed invoice than the 
General Invoice option.   

When this option is used in combination with the One Invoice 
setting for the # of Invoices entry, the labor for each Crop ID will 
be listed on the invoice along with the overhead charges and a 
subtotal is printed for the total charges for each Crop ID. 

General Invoice/Crop, Job. This option creates new line items for 
each job on each specific crop.  

General Invoice/Crop, Job, Date, Crew.  This option creates new 
line items for each job, grouped by crop. This is much like the 
Crop, Job option, except that it also displays the crew. 

General Invoice/Date, Crop. This option creates a new line item 
for each date and crop. It groups and subtotals these by day. 

General Invoice/Employee. This option creates a new line item 
for each employee. In some cases, such as overtime or changing 
pay rate, it may list an employee twice. 

General Invoice/Job. This option creates a new line item for each 
different job.   

General Invoice/Job, Date. This option will create invoices that 
itemize labor for each job/date/crop/crew/wage type/rate 
combination.  This option may only be used with the One Invoice 
setting on the # of Invoices entry.  A subtotal will be printed for 
each job code used for the grower.  The total overhead charges will 
be billed out at the end of the invoice.  This setting also produces a 
more detailed invoice than the General Invoice option. 

General Invoice/Memo. This option will create a new invoice for 
each memo. 
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General Invoice/Time Sheet #. This option will create a new 
invoice for each timesheet. For this to work, you must also use the 
One Inv. Per Timesheet option in the # of Invoices entry. 

General Invoice/Wage Type.  This option will create an invoice 
that prints a single line item for each wage type used to bill the 
labor, followed by lines to bill for commission, taxes, and worker’s 
comp insurance based on the settings on the grower account. 

Labor Contractor Invoice. This option is similar to the General 
Invoice/By Date option in that it itemizes the labor by 
day/job/crop/wage type and rate.  The invoices that are created 
using this option must be viewed and printed from the Labor 
Contractor Invoice Entry window, instead of the Generic Invoice 
Entry window.  

Summary. This will create a single line item to bill the total labor 
and one line for each overhead item that is billed (e.g. commission, 
payroll taxes and worker’s comp).  This is the minimum necessary 
to transmit the income information to the Accounts Receivable 
system. 

Detail by Crew 

This option is available only when you have selected General 
Invoice/Crop, Date for the Update Line Items option.  When 
checked, the labor for each crew is itemized separately.  If you 
uncheck this box, the invoice will combine labor for multiple 
crews working in the same Crop ID together.  This will result in a 
shorter invoice because there are fewer detail lines. 

Bill Charges on Separate Invoice 

This option controls how grower charges will be billed on 
invoices.  By default, this box will not be checked.  Grower 
charges will be billed out along with the labor and overhead 
charges.  To create a separate invoice that lists only the grower 
charges, check this box. 

Charge Minimum Wage Payments 

This checkbox controls whether or not line items added to an 
employee’s check to bring their pay rate up to minimum wage for 
piecework wages are charged to the grower.  If this box is 
unchecked, minimum wage adjustment lines will not have a 
grower account number. 

Minimum wage verification is handled differently when minimum 
wage payments are charged the grower.  Normally the verification 
is done on all of the wages earned on either a daily or weekly 
basis.  But when a grower is charged for minimum wage payments, 
wages are totaled separately for that grower and the minimum 
wage verification is performed on the wages and hours worked for 
each grower.   

This change in the calculation has two primary effects.  First, if an 
employee works for two growers and earns more than minimum 
wage for one grower and less than minimum wage for the other 
grower, the higher wages do not offset the lower wages when 
determining whether or not the employee made minimum wage for 
the entire day/week. 
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Second, by performing a minimum wage adjustment on a per 
grower basis for only that grower’s wages, the Grower Labor 
Report will always show that the employee made at least minimum 
wage.  If minimum wage adjustments are not charged to the 
grower, then those adjustments will not be included in the wages 
reported on the Grower Labor Report.  This means that even 
though the employee is making at least minimum wage, the 
Grower Labor Report does not reflect this. 

Charge Guaranteed Wage Payments 

When an employee is receiving piecework wages and does not 
make the guaranteed wage, the program will automatically add a 
line to make up the difference.  This checkbox controls whether or 
not those wages are charged to the grower.   

Billing Information 
The Billing Information tab page contains the rates and settings to use 
when the Cost+Commission or Fixed+Commission options are selected 
for the grower account: 

 

 

 
Billing Descriptions / % Rates 

These entries are used when the Cost+Commission or 
Fixed+Commission options are selected for the grower account: 

You can enter update to four different descriptions and percentage 
rates to be billed on the grower invoice.  Each description and rate 
will appear on the invoice. 

If you are using the Costs+Workers billing method, instead of a 
percentage, enter the dollar amount per day to bill in the first rate 
entry, and the dollar amount per worker to bill in the second rate 
entry. 

Health Insurance Billing Description 

Enter the text that you want to appear on the line item that bills the 
grower for health insurance costs. 
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Sick Pay Billing Description / % Rate 

Enter the description to use for billing sick pay amounts along with 
the commission rate that you want to charge for sick pay wages 
(whether accrued or paid). 

Overhead Billing Settings 

Checking these boxes will result in the grower invoice billing SUI, 
FUI, FICA, and/or worker's comp insurance on the grower invoice 
as separate amounts.  These items will be billed in addition to any 
billing descriptions and rates entered in the previous section. 

If an FUI Credit Reduction rate applies to your state and you have 
the Bill FUI box checked, the program may bill the extra credit 
reduction rate to growers.  This is controlled by a setting on the 
Program Setup window, Charge Credit Reduction Tax with FUI 
on FLC Invoices. 

Apply Unemployment Wage Limit 

Check this box to apply the state and federal wage limits to the 
unemployment taxes.  Once employee YTD earnings are over the 
wage limits, the grower will not be billed for the unemployment 
taxes. 

Bill Health Insurance 

Costs for providing health insurance coverage to employees may 
be billed to the grower along with commission and other overhead 
items.  Health insurance billing is done based on a set rate per 
hour. 

Rate / Per  

The Rate setting determines how much Health Insurance will be 
billed. 

The Per setting allows you to specify whether the health insurance 
billing will be based on the total of all hours worked (both straight 
hourly and piecework hours) or only for regular hours worked 
(excluding both straight overtime and piecework overtime hours). 

Bill on Separate Invoice 

If this box is checked, the grower labor report will bill all health 
insurance overhead items on a separate invoice instead of 
including the charges with the overhead item(s) on the main 
invoice(s). 

Exclude Employees That Decline Coverage 

If this box is checked, then the program will exclude hours worked 
by employees that have declined coverage.  Because fewer hours 
will be billed, you will likely need to bill a higher rate per hour 
(because the total costs of providing coverage will not change and 
you are billing the grower based on fewer hours).  

Bill Health Insurance on Sick Pay Wages 

By default, the program will not bill growers the per hour Health 
Insurance charge on Sick Pay Wages.  By checking this box, the 
program will includes those hours when calculating the total hours 
to bill the health insurance charge. 
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Bill Accrued Sick Pay 

Check this box to bill out the accrued sick pay. This option is only 
enabled when the Update Line Items option (on the Labor 
Reports/Invoicing Tab) is set to “General Invoice/Employee” or 
“General Invoice/Crop, Date”. 

When that option is set to General Invoice/Employee, the 
program will bill sick pay as another line item on each invoice for 
each employee plus commission. 

When that option is set to General Invoice/Crop, Date, the 
program will bill out a prorated share of accrued sick pay by Crop 
ID plus commission. 

Invoice Settings 
The Invoice Settings tab allows you to tell the program which AR 
divisions to use when creating invoices.  These settings are 
normally used with the Labor Contractor Invoice option for the 
Update Line Items setting. 

Enter the division number to use for labor, commission, and 
insurance in the following entries: 

 
You may press [F4] or click on the lookup buttons to select a division 
number from the lookup. 

You may also specify a specific cost center and/or job code to use on 
the overhead (commission, tax, w/c, and health insurance) line items on 
the customer invoice. 

Print Grower Lists 
Click on the Print List button at the bottom of the Grower entry 
window to print a list of your growers.  The following window will 
open: 
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Select the order that you want to print the report in and the type of 
report.  The Abbreviated report will print one line per grower with the 
account number, name key, grower name, and phone #1.  The Name & 
Address option will add the address and phone #2.  The Detailed option 
will add the commission billing rates to the report. 

Click on the Print or Preview buttons to run the report. 
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Job Code Setup 
The Job Code file is where you set up the types of work the employees 
are performing.  Depending on your settings in the Program Setup, you 
may have a different term used for the Job Code file.  For instance, on 
your system, it may be called a Activity, Phase or Operation Code.  To 
avoid confusion, in the documentation it is always referred to as the 
“Job Code”. 

To enter or edit your Job Codes, select the Job Setup option on the 
Labor Reports menu.  The following window will open: 

 
Job ID 

Enter a code on each line of up to eight letters or numbers.  This 
can be a abbreviation ("PR" for pruning, for instance) or you can 
use numeric codes.   

If you use numeric codes, we recommend using leading zeros (i.e., 
enter "01" instead of "1" if your codes are under 100, use "001" if 
your codes are over 100").  Codes are sorted alphanumerically, so 
the leading zero is needed to display them in order. 

Description 

Enter a description here for the job.  This description will appear at 
the bottom of the data entry windows and will appear on the 
grower labor report and grower invoices. 

G/L # 

You can enter a default general ledger account here to use.  A G/L 
# is not required, this is an optional entry.  If entered, the G/L 
number will be used as a default on check entry.  For instance, if 
you have a general ledger account for Weed Control, and there are 
eight different job codes that should always fall under Weed 
Control, you should enter the general ledger account for Weed 
Control on these job codes.  Then when you enter checks and use 
these job codes, the general ledger account for Weed Control will 
automatically be used. 
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Press [F4] or click on the column header to get a lookup of General 
Ledger accounts. 

Charge Rate 

This entry allows you to specify a default rate to use when entering 
grower charges or invoices in the accounts receivable module. 

Active 

This box should be checked for all active Job Codes.  If you are no 
longer using a particular job code (i.e. it is obsolete or will not be 
used again) then you can uncheck this box and it will not appear on 
the Job Code list or on the lookups. 

Equipment Flag 

This entry determines whether or not the program will require a 
entry for the equipment used.  If you do not have the equipment 
charge out option enabled, you can leave the default value of “O” 
for this entry. 

If this job code is not one where you will be charging the grower 
for the use of equipment, you may simply enter “N” for this entry.  
During payroll entry, the program will automatically skip over the 
equipment ID entry. 

Enter “Y” to require an equipment code on the payroll entry when 
this job code is used.  The program will not let the payroll line be 
saved until an equipment ID is entered. 

You can also enter “O” to make the equipment ID entry optional.  
The program will not skip over the entry, but it will also not 
require and entry before saving the line. 
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Crop/Field Setup 
The Crop File allows you to set up a list of crops, varieties, ranches, or 
locations.   

Descriptions for crops can be entered and will appear on employee 
check stubs and grower labor reports.  You can enter generic 
descriptions (as shown below) or enter specific ranch names, locations, 
block numbers, etc. for individual growers in the crop table. 

On the Grower Labor Report and the invoice that the program prints 
automatically, subtotals will be printed for each different crop that was 
used for the payroll period. 

To open the Crop entry window, go to Labor Reports->Crops.  The 
following window will open: 

 
Crop ID 

Enter an ID for the crop.  This can be an abbreviation of up to eight 
letters/numbers. 

Description 

Enter the description for this crop entry. 

Commodity 

Enter the commodity, if different from the description.  (Optional) 

Grower # 

If this Crop ID is specific to one grower, enter the grower’s 
account number here.  During payroll entry, the program will 
automatically default the grower # entry when this Crop ID is used. 

Comm % 

This column is used when you have selected the Cost+Crop ID 
Comm % option for the Billing Method setting on the grower 
account.  This setting allows you to charge a different commission 
percentage for different Crop IDs. 

Acreage  

Enter the number of acres for this crop. (Optional) 
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W/C Code 

Enter the worker’s comp class code to use for this crop ID.  The 
rate will automatically default if you enter the class code. 

W/C Rate 

Enter the worker's comp rate for this crop. 

Active 

If this crop ID is no longer used, uncheck this box. 
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Equipment Cost Centers 
Equipment cost centers allow you to track costs for repairs, 
maintenance, and operation of individual pieces of equipment. In 
addition, you may also charge the cost of using equipment to the 
various cost centers when equipment is used.  Equipment costing is an 
optional feature that must be turned on in the Program Setup.  

Once enabled, you can find this window at Cost Accounting-
>Equipment Setup. 

 
Equipment ID 

Each piece of equipment must be assigned a unique ID number, 
just like your crop cost centers. 

Description 

Enter up to two lines for a description of each equipment. 

Year 

Enter the model year for this equipment entry (Optional). 
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License # / VIN 

If applicable, enter the license plate and VIN numbers of the 
equipment. 

Chargeout Rate 

This is the default rate to charge crop cost centers per hour for use 
of this equipment. 

Last Used On 

This will display the last time it was used. This updates 
automatically. 

Crop Year / Hours Used 

This grid displays the total amount of time that the equipment was 
used for each crop year. 

Billing Settings 
The Billing Settings tab can be used to bill a customer for use of this 
equipment. The following entries can be used to do this. 

Bill Expenses posted to this Equipment ID to… 

Check this box to bill this equipment’s expenses to a customer. 

Customer Acct # 

Select the customer by entering the account number here or using 
the lookup button. 

% of Expenses to Bill 

Enter the percentage of the total equipment expenses that you 
would like to bill to this particular customer. 

Labor Markup 

Select whether or not you will markup these expenses. If so, add 
the markup percentage. 

Billing Rates 
The Billing Rates tab can be used to set up certain rates for this 
equipment for individual Job IDs. These rates will be used to 
accumulate the expenses for using this equipment. To add a rate, 
simply select a Job ID and enter the rate. For more info on how to do 
this, see the prompts below. 

 
Job ID 

Select a Job ID by entering it here, pressing [F4] or clicking on the 
Job ID heading. The two latter options will bring up the Job ID 
lookup where you can select the Job. 

Jake Luker
Needs expanded docs
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Description 

The description of the Job will automatically appear in this box. 

Bill Rates 

Enter the billing rate for the job. 
Links 

Use the Links Tab to link this piece of equipment to another piece of 
equipment, an employee, G/L # or Job ID.  

 
When this equipment is used, use the following equipment also: 

You can link one piece of equipment to another so that when the 
first one is used, the second one is automatically used as well.  
Enter the ID of the second piece of equipment here, or click on the 
lookup button (or press [F4]) to select an entry.  Click on the Clear 
Link button to clear the secondary equipment ID. 

 

Use this equipment when a check is entered for the following 
employee and expense: 

These entries enable you to set this equipment entry as the default 
when you are entering a check for a particular employee and job.  
You must select the employee that will be using this equipment, as 
well as the job by entering the G/L wages expense account and job 
# if you are using job codes.  When you are entering a check that 
matches all of these entries, the equipment ID will be entered 
automatically for you on the check line item. 

Click on the Clear Link button to clear the employee, G/L #, and 
Job code fields. 
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Cost Accounting 
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Introduction to Cost Accounting 
Cost accounting provides you with information for management 
purposes, as opposed to financial or tax purposes.  The idea behind cost 
accounting is to identify how various parts of your business are 
contributing to your operation as a whole.  In the case of a farming 
operation, you can use this information to make decisions such as: 

 

• Whether or not to continue growing a certain crop based 
on its profitability 

• Whether to standardize on a certain cultural practice you 
are testing out  

• Whether to increase or decrease acreage for a particular 
crop 

• Whether you can make a profit growing a crop under 
contract for a fixed price. 
 

How cost accounting works 
In The Farmer’s Office, each part of your operation that you want to 
track profitability for is called a cost center.  Other systems may refer 
to them as enterprises, hence the term "enterprise accounting" is also 
used to describe cost accounting.  We also use the term Crop Reports to 
describe cost accounting, since you print Crop Reports to analyze the 
information that you have fed into the system. 

When you record income or expenses, you assign them to cost centers.  
You also assign a crop year to income and expenses.  This is done to 
get an accurate picture of each season.  Each crop you grow may have a 
different growing and harvesting season.  In addition, these periods 
may not coincide with your fiscal year, and in fact may overlap 
multiple fiscal years. 

Also, by keeping records by both fiscal and crop year, decisions that 
you make for tax purposes do not interfere with cost accounting 
records.  For instance, you may decide to prepay certain expenses for 
the next crop year before the end of the tax year, or postpone receiving 
payments for a crop until the next fiscal year.  In these cases, The 
Farmer’s Office allows you to maintain accurate profitability records 
on both your fiscal year and a crop year basis. 

Besides overall profitability, the crop reports provide you with 
additional management information, including your income and 
expenses on a per acre and per yield basis.  For each crop year, you can 
track planted acreage and yields.  For permanent crops, your planted 
acreage would normally stay the same from year to year, but for open 
ground crops it may vary.  Yields can be measured in whatever unit 
type is appropriate for the crop, for example pounds, tons, bales, boxes, 
etc.  Per acre and per yield figures provide you with a basis for 
comparing performance between different cost centers as well as from 
year to year. 

How to set up your cost centers 
Because cost accounting is a tool to provide you with management 
information, it is up to you to decide how you will set up your cost 
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centers.  Basically you must decide how detailed you want the 
information to be.  For example, one grower may want to put all his 
peaches under one cost center; another grower may want to put each 
variety of peaches under a different cost center; and yet another grower 
may want to set up each block for each variety of peaches as a separate 
cost center.  Each grower may have different considerations for setting 
up their cost centers so that they get more or less detailed information 
on their crops.  Suppose you have multiple fields where you are 
growing cotton.  Are you just concerned about overall profitability of 
cotton, or do you want to be able to compare performance of each 
field? 

How you set up your cost centers will determine the management 
information you will get, but what happens if you decide a year or two 
down the road that you aren’t getting the information you want?   Don’t 
worry, you can scrap your current system and start over, adding to or 
changing your cost centers and expense categories.  If you do this, the 
major impact this will have is whether or not comparisons between data 
before and after the change will be meaningful or even possible. 

It usually is best however, to give as much thought as possible in the 
beginning to how your cost centers are set up.  Take the last example of 
setting up cost centers for cotton.  Suppose you are growing cotton on 
three different fields, but you only set one cost center to track all 
cotton.  Now suppose that your cotton is marginally profitable, or 
worse, you are losing money.  Is it because of higher expenses or lower 
yields on one field, or is cotton just doing bad overall?   With just one 
cost center for all cotton, you cannot easily tell if one or two fields are 
profitable enough to continue farming.  But if you are tracking all three 
fields as separate cost centers, you may decide to take one unprofitable 
field out of production and grow something else on that land, but keep 
the other two growing cotton. 

Tradeoffs to consider 
Having the most detailed and accurate figures to base your 
management decisions on is the ideal situation.  In the real world, 
there’s always the other side of the coin.  In this case, keep in mind that 
there is a cost to gathering and recording detailed information.  And 
depending on the situation, the person entering data on the computer 
may find it difficult (sometimes impossible) to get others (the people 
actually out in the field) to record and keep accurate figures to bring 
back to the office.  You may need to strike a balance between keeping 
detailed records and the effort required to get them.  In some cases, 
reasonable estimates, past experience, or best guesses may have to 
substitute for exact figures. 

The ability to do cost accounting is one of the features that sets The 
Farmer’s Office II apart from generic, "off-the-shelf" accounting 
systems.  General purpose software such as Quicken, Quickbooks, and 
Peachtree have limited cost accounting capabilities that don't usually 
translate well to farming enterprises. The Farmer’s Office is designed 
specifically for farming operations because it: 

 

• Tracks income and expenses on a crop year basis. 

• Allows you to see income and expenses on a per acre and 
per yield basis. 
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• Has reports specifically designed for crop cost 
accounting. 

• Supports using overhead cost centers. 

• Allocates general overhead costs (those not assigned to a 
specific cost center). 

• Allows you to set up budgets on a cost center/crop year 
basis. 

• Overhead expenses for payroll (employer taxes and 
worker’s comp insurance) are automatically allocated to 
cost centers for accurate expensing 

• Includes features (such as the Acreage Split Worksheet) 
to make it easier to assign expense to cost centers. 

• Can track expenses for equipment maintenance and 
operation, and expense equipment usage to crop cost 
centers 
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Overview of Cost Accounting Features 
Crop Reports (P&L) by Cost Center.  The basic reporting function of 
a crop cost accounting system.  Provides you with the income and 
expenses for an individual cost center for a single crop year.  Your crop 
year may overlap multiple calendar or fiscal years. 

Comparison Crop Reports.  Prints data from two separate crop years 
on the same report to allow you to see changes and variations.  May 
also be printed to compare actual expenses to budgeted amounts. 

Expense Breakdown by Crop.  Expense report allows you to see what 
portion of each expense category has been allocated to each cost center. 

Export Crop Report Data.  This option allows you to save the raw 
crop cost transactions in a file that may be imported into a spreadsheet 
for further analysis.  This option is designed for advanced users who 
wish to generate their own reports or perform additional calculations on 
crop income and expense data. 

Monthly Crop Report.  This reports give you a snapshot view of 
income expenses, allowing you to easily see when and where your 
money went.  It prints in a spreadsheet-like grid format, with columns 
for each month and rows for each expense category. 

Ranch Overhead Allocation.  Ranch overheads allow you to expense 
items that apply to several different crops on a ranch to a single ranch 
cost center.  The crop reports then apply a percentage of the total 
expense to each individual field cost center that is included on that 
ranch.   

Crop/Variety Overhead Allocation.  Similar to ranch cost centers, 
crop cost centers may include multiple field cost centers of the same 
crop or variety.  The crop reports then apply a percentage of the total 
expense to each individual field cost center that is included on that crop 
or variety. 

General/Administrative Expense Overhead Allocation.  This feature 
allows you to designate a percentage of your general & administrative 
expenses to be included with the expenses on crop reports. 

Job Categories.  Using the job categories (also called phases or 
activities in other systems) you may set up general expense descriptions 
on your general ledger chart of accounts (e.g. Labor) and set up specific 
categories (e.g. Pruning, Harvest, Irrigation, Tractor Work, etc.) in the 
job file.  This gives you the flexibility of having general or summary 
amounts appear on your financial reports, while the crop reports have 
more detailed totals. 

Budget Entry by Cost Center/Date.  An important planning tool, the 
budgeting program allows you to enter budgets with as much detail as 
desired.  This information is used for reporting and comparison to 
actual expenses. 

Generate New Budgets Automatically.  You will save time by 
generating budgets for new crop years automatically, either from a 
prior year budget or from your actual expenses. A percentage increase 
or decrease can be factored into the new budgets.  Then individual 
entries may be adjusted as needed. 
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Cash Flow Worksheets.  This report will show you budgeted expenses 
month by month.  A master cash flow worksheet can be generated 
which combines the budgets for all cost centers. 

Acreage Split on Invoice/Check/Deposits.  When recording expenses 
and income, the acreage split feature can be used to automatically 
distribute the total between different cost centers.  This is similar to the 
Ranch or Crop Overhead feature, but with a few differences.  You can 
have the program memorize groups of cost centers used on an acreage 
split and re-use that group on later transactions. 

Consolidated Crop Reports.  This report combines multiple cost 
centers into one crop report.  This can be used to get a variety or ranch 
report. 

Memo Crop Cost Expenses.  Memo crop expenses are useful when 
you need to record expenses against a cost center without affecting the 
general ledger.  For instance, under a sole proprietorship, the owner 
gets money through owner’s draw instead of getting a payroll check.  If 
you want to expense out the owner’s time to cost centers and expense 
categories, you can use the memo crop cost expenses. 

Crop Notes.  The Crop Notes feature is basically an electronic 
notebook for recording whatever information you need on cultural 
practices, pesticides applications, soil sample results, temperatures, 
yields, etc.  Notes can be referenced by cost center, expense categories, 
and crop year. 

Payroll Overhead Expense Allocation.  Employer payroll taxes and 
worker’s compensation expenses are automatically allocated to cost 
centers based on the wages expensed when payroll check information is 
entered.  This gives you much more accurate costing data for expenses 
that would otherwise be difficult to allocate. 
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Cost Centers 
When you select the Setup Cost Centers option on the Cost Accounting 
menu, the follow window will open: 

 
Cost Center ID 

You assign each cost center it's own unique ID # of up to eight 
letters or numbers.  Use a code that is short and easy to remember.  
For instance, you might use combinations like "HOME40" or 
"DADS30".  Or suppose you have different ranches, and each field 
has a map number assigned to it.  You might use something like 
"RR01" to mean "River Ranch, field #1". 

If you assign numeric ID numbers, you may want to use leading 
zeros, for instance, use "01", "02", "03" instead of just "1", "2", 
"3".  This will insure that cost center ID's are listed in the correct 
order. 

Cost Type 

Select the appropriate type of cost center.  The "basic" types are 
Block, Field, Herd, Orchard, and Vineyard.  Each of the basic 
types may be included under an overhead cost center.  The two 
types of overhead cost centers are Ranch and Crop/Variety. 

Description 

Enter a description for the cost center.  This may be a commodity, 
location, ranch name, etc. 
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Commodity/Var Code 

Enter the commodity for this cost center.  If the commodity is 
included in the description, or you grow different crops on this cost 
center from year to year, you can leave this entry blank. 

If you have turned on the Commodity/Variety Code feature, then 
the program will change this entry to ask for the 
Commodity/Variety Code. 

Acreage 

Enter the acreage for this cost center.  (If the planted acreage varies 
from year to year, you can enter the total acreage and specify how 
many acres are planted from year to year on the Yields/Overhead 
tab page. 

Location 

Two lines are provided for entering location or other information. 

Current Crop Year 

If you have different crops that have overlapping crop years, you 
can enter the current crop year here.  This will be used as a default 
during check/deposit entry, overriding the current crop year in the 
System File.  If you leave this entry blank, then the default crop 
year will be used from the system file. 

For instance, suppose you are harvesting citrus in December 
2000/January 2001, and you are using 2000 as your crop year for 
your citrus crops.  In January, you are also replanting in your 
almond orchard and winter pruning, and these expenses are a part 
of your 2001 crop year for almonds.  In this case, you may want to 
have the current crop years set different on each of the cost centers. 

Planting Date / Harvest Date 

Enter the planting and harvesting dates for this cost center. Press 
[F4] or use the lookup button to access a date picker. 

Work in Progress 

Check this box if you are using this as a Work in Progress cost 
center. 

Row Counts 

If you have the Row Counts option enabled in the System File, you 
can check this box to indicate that row counts are used for this 
particular cost center.  Leave it unchecked if you do not use row 
counts for this cost center. 

For instance, if you grow raisin grapes, cotton, and almonds, you 
may only check the Row Counts box for your raisin cost centers.  
When entering payroll on the cotton and almonds, the Row # entry 
will be skipped because the program will know that row counts are 
not used for these crops. 

Allow This Cost Center on Payroll Entries / Payables Entries 

If these boxes are checked, this cost center can be used when doing 
payroll or accounts payables. 
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Charge Payroll Overhead as Percentage 

Normally, payroll taxes and worker's comp overhead will be 
expensed exactly to the cost centers labor is expensed to.  You can 
override this default behavior by checking this box.  When it is 
checked, the payroll journal will instead charge a flat percentage of 
the wages to the payroll tax account.  Enter the percentage to 
charge for payroll overhead to the right. 

Yields/Overhead 
The Farmer's Office maintains information for each crop year for 
historical reporting and comparison purposes.  The Yields/Overhead 
tab page lists this information for each cost center: 

This tab page includes information on the overhead cost centers the 
percentages to allocate from each overhead.  While you can edit the 
overhead cost centers and percentages on this tab page, it is usually 
easier to use the Overhead Setup button on the Crop Info tab page to 
allocate costs from overhead cost centers. 

Year 

This is the crop year for this line (and the overhead information 
displayed below the grid).  If you want to make an entry for a new 
crop year, click on a blank line (or arrow down to it) and type in 
the crop year here. 

Yield 

Enter the total yield for this cost center/crop year.  The number you 
enter here will be used for calculating income and expenses per 
unit yield. 

Unit Type 

Enter the type of units you measure the yield in, for instance, tons, 
bales, pounds, boxes, etc. 

Planted Acres 

This is the total planted acreage for this crop year.  This entry will 
automatically default to the acres entered in the cost center file.  
For open ground crops you can override this and enter a different 
planted acreage for each crop year.  

Description 

If desired, enter a brief description. 

Ranch Overhead 

Enter the cost center ID for the first overhead for this cost center.  
(The default overhead type for the first overhead is Ranch.) 

Percentage 

Enter the percentage to allocate to this cost center from the first 
overhead cost center. 

Crop/Variety Overhead 

Enter the cost center number for the second overhead for this cost 
center.  (The default overhead type of the second overhead is 
Crop/Variety.) 
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Percentage 

Enter the percentage to allocate to this cost center from the second 
overhead cost center. 

Overhead (#1) 

Enter the cost center number for the third overhead for this cost 
center.  (There is no default overhead type for the third overhead, 
so this will either not be used or it will show the overhead type that 
you have defined.) 

Percentage 

Enter the percentage for the third overhead allocation. 

Overhead (#2) 

Enter the cost center number for the fourth overhead for this cost 
center.  (There is no default overhead type for the third overhead, 
so this will either not be used or it will show the overhead type that 
you have defined.) 

Percentage 

Enter the percentage for the fourth overhead allocation. 

General Overhead % 

Enter the percentage of the General/Administrative overhead 
expenses that you want charged to this cost center/crop year.  The 
crop reports will calculate the total general overhead using the 
parameters below. 

Starting GL # / Ending GL # 

The Starting and Ending General Ledger numbers are used by the 
crop reports to calculate the total general overhead.  All expenses 
that have a general ledger account in this range and are not 
expensed to a cost center will be considered a part of the general 
overhead. These entries do not need to be filled in if you are not 
using the general overhead calculation feature. 

Starting Date / # of Months 

The Starting Date and the # of Months entries are also used to 
calculate the total general overhead.  Expenses are selected by 
date, and must fall within the range determined by these entries.  
For example, if the starting date is 10/01/98 and the number of 
months is set to 7, all expenses that fall between 10/01/98 and 
04/30/99 will be included in the general overhead. These entries do 
not need to be filled in if you are not using the general overhead 
calculation feature. 

Planting Date 

Enter the planting date for this cost center. Press [F4] or use the 
lookup button to access a date picker. 

Beginning Harvest Date / Ending Harvest Date 

Enter the harvest season by entering the first and last date of it. 
Calculating Income/Expense Per Tree or Vine 

For permanent crops, in addition to providing per acre and per yield 
figures on the crop reports, you can also get crop reports that show your 
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income and expenses on a per tree or per vine basis.  All you need to do 
is put the number of trees or vines in the Yield entry of the crop report 
data file, and "TREE" or "VINE" in the Unit Type entry.  Then print 
the crop reports.  When you are done, you can put the actual yield and 
unit type back in. 

Knowing your per tree or vine costs on labor expenses may be helpful 
if you are currently paying employees on an hourly basis, and are 
thinking of switching to piecework-based pay.  This gives you a 
starting point for determining piecework rates. 

 
W/C Rates 

This table is used to determine the worker's comp rate to apply to labor, 
as well as the payroll tax expense and worker's comp expense accounts 
to use for accruing taxes and worker's comp. 

When a new Cost Center is saved, an entry is created in the Payroll 
Setup Workers Comp screen.   If you don’t assign the Cost Center to a 
Workers Comp Class Code or Rate on the W/C Rates tab you can do so 
through the Payroll Setup Workers Comp window.  If you enter the 
W/C Class or Rate information in the Cost Center file, it will 
automatically be added to the Workers Comp Setup window in the 
Payroll system.   

In the simplest example, with farm-only payroll, you may leave the G/L 
# and Job ID blank.  The program will assign the tax liability and 
workers comp class based on the cost center entered on the payroll 
check.  This entry would look like this: 

 
To extend this example, suppose you have an office worker who has a 
different worker's comp rate (and you want to keep the payroll 
overhead for office wages separate from farm wages).  In this case you 
should have a general ledger expense account for office wages, and you 
would enter this in the first column, and leave the job column blank.  
The program will match the office wages general ledger account 
entered on the check to this entry, and thus will use it for the worker's 
comp rate and general ledger expense accounts.  This entry would look 
like this: 
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When determining the entry in this table to use, there is a specific order 
that is used to search the table.  The program will use an entry from the 
table based on the first entry that matches: 

1. The general ledger account, job code, and cost center 

2. The general ledger account and cost center 

3. The job code and cost center 

4. The general ledger account 

5. The cost center 

 
Overhead Cost Center Setup 

Ranch and Crop/Variety Overhead cost centers allow you to divide an 
expense automatically among multiple field, block, orchard, or 
vineyard cost centers.  To do this, the program must know which cost 
centers make up the overhead, and how much (what percentage) to 
allocate to each cost center. 

When you are editing an overhead cost center, the Overhead Setup 
button will be enabled.  When you click on the button, the following 
window will appear: 

 
Year 

Each overhead cost center may have a different allocation setup for 
each crop year.  The current crop year will be displayed here 
automatically.  You can change this to a prior crop year by clicking 
on the drop down button. 

Overhead settings for a new crop year may be created from this 
window by clicking on the New Year button.  See the instructions 
below for more information. 

Add... 

When you click on the Add... button, a window will appear for you 
to select a cost center to add to the list. 

Type in the cost center ID or click on the lookup button to select a 
cost center.  Click on Ok to add the cost center, or Cancel to close 
the window without adding anything. 

Remove 

The cost center currently highlighted will be removed from the list. 
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Allocate 

As you add cost centers, you will notice that the "% of acreage" 
column will show the percentage of the total acreage of the cost 
centers listed.  This will change as you add or remove cost centers.  
The "Overhead %" column shows the actual percentage currently 
assigned to each cost center. 

When you click on the Allocate button, the percentages in the "% 
of acreage" column will be copied to the "Overhead %" column. 

In addition to automatically assigning the Overhead % by acreage, 
you can click on any of the overhead percentages and type in a 
different value.  The percentages, of course, must total 100. 

If you make changes to the overhead allocation, click on Ok to save the 
changes.  If you don't want to save the changes you have made, click on 
Cancel. 

Setting Up Overheads for a New Crop Year 
When you click on the New Year button, the following window will 
appear: 

 
Enter the new crop year that you want to create overhead entries for, 
which crop year you want to copy the entries from, and whether you 
want to create entries for all overhead cost centers or just the one you 
are currently working on.  Click Ok to create the entries, or Cancel to 
close the window without creating anything. 
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Print Cost Center List 
Click on the Print button on the Cost Center window to print a list of 
your cost centers.  The following window will open: 

 
This window will generate a list of your cost centers. Without changing 
any options, it will print a list of all of your cost centers. However, each 
option on this window will change which cost centers appear on the 
list. Each entry is a different parameter to refine the list by. 

Crop Year to Print 

The cost center list includes information from the crop year file, 
including yields and overhead setup information.  Enter the crop 
year that you want to print on this report. 

You can leave this blank if you aren't concerned about getting the 
information specific to the crop year on the list. 

Only Print Cost Centers For This Crop Year 

Check this box if you only want the report to include cost centers 
with entries in the crop year file for the year you entered. 

Print Equipment Cost Centers 

Check this box if you want to print equipment cost centers also.  
Otherwise they will be excluded. 
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Customer # 

If you want to print cost centers for a particular customer, enter the 
customer # here. 

Comm/Var Code 

Filter the list by Commodity or Variety by entering a code here. If 
you select a commodity or variety, only cost centers that include 
the chosen comm/var code will be included. 

Planting Date from…to… 

Filter the report by planting season by entering the first and last 
planting dates. 

Harvest Date from…to… 

Filter the report by harvest season by entering the first and last 
harvest dates. 

Select… 

Select which cost centers to include based on activity status. This 
can be Active, Inactive, or All. 

Print… 

Select what info you want to print on the list. This can be the 
Overhead Information or the Plant/Harvest Dates. 

Print Order… 

Select the print order for the list. There are 5 different options: 
Crop ID, Customer/Crop ID, Cost Type/Crop ID, Ranch, 
Crop/Variety. 

When there are two parameters in a given option (such as 
Customer/Crop ID), the list will be sorted by both. The first will be 
the first sorting parameter and the second one is the subheading. So 
for instance, Customer/Crop ID will show each Crop ID for every 
Customer. 

Custom List / Customize 

This list can be customized. This allows you to gather other 
information about Cost Centers that wouldn’t normally be 
included.  

To do this, check the Custom List box. Then use the Customize 
button to modify the list. 

Preview 

Click on this button to see a preview of the report on the screen. 

Print Setup 

Click on this button to select a printer to use for this report. If you 
do not select a printer, the report will automatically be printed to 
the current default printer.  To see the current printer, you can 
move the mouse pointer over the button and a tool tip will appear 
showing the printer name and port. 
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Print 

Click on this button to print the report to the current printer.  To 
see the current printer, you can move the mouse pointer over the 
button and a tool tip will appear showing the printer name and 
port. 

Cancel 

Click on this button to close the window. 
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Equipment Cost Centers 
Equipment cost centers allow you to track costs for repairs, 
maintenance, and operation of individual pieces of equipment.  In 
addition, you may also charge the cost of using equipment to the 
various cost centers when equipment is used.  Equipment costing is an 
optional feature that must be turned on in the Program Setup.  If it is 
enabled, you will have an option for Equipment Cost Centers on the 
Cost Accounting menu.  This window will be opened when you select 
that option: 

 
Equipment ID 

Each piece of equipment must be assigned a unique ID number, 
just like your crop cost centers. 

Description 

Enter up to two lines for a description of each equipment. 

Year 

Enter the model year for this equipment entry. (Optional). 
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License # 

VIN 

Chargeout Rate 

This is the default rate to charge crop cost centers per hour for use 
of this equipment. 

Last Used On 

Crop Year 

Hours Used 
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Job Codes 
If you have used other ag 
accounting systems, you 
may be used to different 
terminology.  Job codes in 
The Farmer’s Office are 
equivalent to phases in 
Famous, activities in 
Frontier, and operations in 
AgData. 

When entering expenses, you will enter a general ledger account, which defines 
the “type” of expense you are recording.  You can use job codes to provide more 
detail (in addition to the general ledger account) on the cost accounting reports 
for the types of expenses you have incurred.   

For instance, you may have one expense account for “Field Labor”.  For 
accounting purposes, on your Profit or Loss report you want to only want to see 
one total for all labor, across all fields and jobs.  But for cost accounting reports, 
you do want to see a breakdown of labor for different jobs (pruning, suckering, 
tying, irrigating, pesticide applications, harvest, etc.).  By using the job codes, 
you can get this detail on the cost accounting reports, while retaining a single 
account on the financial reports where the breakdown is not needed. 

This applies not just to labor but to any general ledger account you use 
for cost accounting.  For instance, you might also set up a general 
ledger account for Chemicals, and create job codes for Fertilizer, 
Herbicides, Pesticides, Defoliants, Fungicides, etc. 

When you select the Job Code option on the Cost Accounting menu, 
the following window will appear: 
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Job ID 

Enter a code on each line of up to eight letters or numbers.  This 
can be as an abbreviation ("PR" for pruning, for instance) or you 
can use numeric codes.   

If you use numeric codes, we recommend using leading zeros (i.e., 
enter "01" instead of "1" if your codes are under 100, use "001" if 
your codes are over 100").  Codes are sorted alphanumerically, so 
the leading zero is needed to display them in order. 

Description 

Enter a description here for the job. 

Expense G/L # 

You can enter a default general ledger expense account here to use.  
A G/L number is not required; this is an optional entry.  If entered, 
the G/L number will be used as a default on check entry.  For 
instance, if you have a general ledger account for Weed Control, 
and there are eight different job codes that should always fall under 
Weed Control, you should enter the general ledger account for 
Weed Control on these job codes.  Then when you enter checks 
and use these job codes, the general ledger account for Weed 
Control will automatically be used. 

Press [F4] or click on the column header to get a lookup of General 
Ledger accounts. 

WIP G/L # 

This entry can be used to designate the default G/L # to use when 
entering an expense to a work in progress cost center.  A work in 
progress cost center will generally have all expenses posted to an 
asset account.  The expenses are later moved to the Expense G/L # 
by the Work In Progress posting report.  

Managed G/L # 

In some cases, farm management companies may also have cost 
centers that belong to them in addition to providing management 
services.  The chart of accounts may be set up with different 
expense accounts for internal and external cost centers.  In these 
cases, the Expense G/L # can be used for internal cost centers, and 
the Management G/L # can be used for the external cost centers 
(expenses that will be billed). 

Group 1/2/3/4 

Groups are used for reporting purposes.  You can set up groups 
and assign each job code to up to four different groups.  On cost 
accounting reports, job codes that are assigned to the same group 
will be printed together and subtotaled. 

When you run a cost accounting report, you may select which 
group assignment (1/2/3/4) you want to use for grouping and 
subtotaling the job codes. 

For farming management companies, Group 2 codes are always 
used for the Investor Summary Reports. 
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Job ID Type 

The Job Type is a 2 digit numeric user defined category for your 
job codes that can be used for reporting purposes.  Job types are set 
up under the Cost Accounting->Setup sub-menu. 

As an example, you might have different job types for different 
types of expenses for different cultural activities, e.g. separate job 
codes for pesticide application (labor, materials, equipment, labor 
overhead).  A group could be assigned to combine different types 
of expenses for the same cultural activity (pesticide application in 
this example) while different job types would be assigned to the 
job codes for labor, materials, equipment. 

When reporting by job type, this would allow you to group and 
subtotal all labor job codes, all material job codes, etc.  

Equipment Entry 

This entry controls whether or not an entry is required for 
equipment costing when this job code is used.  Select “No” to skip 
the equipment costing entries automatically.  Select ‘Required” to 
require an equipment ID when this job code is used.  Select 
“Optional” (the default) to make the equipment entry optional. 

Charge Rate 

This is a default rate used for billing purposes.  You can set up a 
default rate that will be entered for you automatically on customer 
invoices when this Job ID is used for billing. 

The charge rate will also replace the pay rate when the Create Crop 
Invoices option generates invoices from payroll expenses. 

When using the Grower Labor Report to bill payroll, the Charge 
Rate is also used to replace the pay rate when a grower account is 
set to Fixed Rate/Job Code Charge Rate for the Billing Method 
setting. 

Active 

Job codes that are no longer used can be marked as inactive by 
unchecking this box. 

Expense / Budget 

These checkboxes determine whether the job code will be used for 
entering expenses and/or for budgeting purposes. 

Normally, a job code is used for both.  In some cases, you may 
want to set up budgets using budget-only job codes.  A budget-only 
job code allows you to group several related job codes that are 
used to track expenses into one budget category.  This is where the 
next entry is used. 

Budget Job ID 

For any job codes that are not used for budgeting (i.e. are only 
used for entering expenses), do not check the Budget checkbox.  
This will enable the Budget Job entry where you can select the job 
code that is used for budgeting this particular activity. 
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Payroll O/H Job ID 

If entered, the Payroll O/H Job ID will be used for the payroll tax 
and workers comp expense transactions accrued by the Payroll 
Journal for labor billed under this job code.  This is typically used 
when doing Work In Progress accounting.  This allows your labor 
and overhead costs to be posted under different job codes.  When 
the WIP Posting is done, these two different job codes can point to 
two different general ledger expense accounts, one for the labor 
and one for the payroll taxes and worker’s comp expense. 

Equipment Job ID 

If entered, the Equipment Job ID will be used for the equipment 
charges generated by the payroll journal for equipment usage 
entered on the payroll checks. 

Bill expenses for this code on farm management invoices 

This setting is used for farm management billing.  It will be 
disabled if the farm management billing option is not enabled. 
Normally this box will be checked, so that expenses entered under 
this job code will be billed to customers.  If you uncheck this box, 
the program will not bill any expenses posted under this job code 
to customers when you use the Create Invoices option.  

Billing Type 

This setting allows you to control the sale type that is used by the 
program when it creates the line items on the customer invoice.  
Normally all line items will have a Non-Taxable billing type, but if 
you need to charge sales tax for some items, you could set up a job 
code that will bill items out under the Taxable type.   

Other sale types could be used to control which general ledger 
accounts income is posted to. 

Invoicing Job ID 

The Invoicing Job ID is used for a custom farm management 
invoicing option.  This entry allows you to group billing amounts 
for several different job codes together under a single “main” job 
code.   

Budget Only Job Codes 
As mentioned in the instructions for setting up job codes, it is possible 
to set up job codes that are used for only budgeting purposes, job codes 
that are only used for expenses and job codes that are used for both 
budgets and expenses. 

In most cases, you can set up all of your job codes to be used both for 
budgeting and expensing.  If you’re not sure why you would need to 
use job codes only for budgeting, then you’ll probably never need to 
use budget only job codes. 

Cost Centers 
The Cost Centers tab page allows you to specify which cost centers a 
job code can be used for.  This provides a validation system to prevent 
invalid combinations of cost centers and job codes. 
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When you add a cost center to the list for a job code, that job code will 
automatically appear on the Job IDs tab page for that cost center on the 
cost center setup window.  In other words, both tab pages can be used 
to maintain the same validation table information. 

If you do not enter any cost centers, then the default behavior of the 
program is to allow any combination of cost centers and job codes on 
transaction entry.  But as soon as one entry is added to the validation 
table for a cost center, the table must contain entries for all job codes 
that you want to be able to use for that cost center. 

Click on the Add Multiple button at the bottom of the window to 
select and add multiple cost centers at once. 

Printing a List of Job Codes 
Click on the Print button in the bottom left corner of the Job Setup 
window to print a list of your job codes.  The following window will 
open: 
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Select the order that you want to print the job codes in, as well as 
whether you want to print only active, only inactive, or all job codes.  

Click on the Customize button to add or remove items from the report.  
By default, most items in the job code setup will print on the list.  
However, if you don’t use certain items, you can remove them from the 
report. 
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